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Remember that Channel Mapping is used to set the input channels for your transmitter.  
This means that you are setting the channels used to monitor physical movements or 
positions of your transmitter’s sticks, switches, and knobs.  Unless you change 
transmitters, you should only need to set this once.  Only use the Channel Mapping… menu 
item to tell RealFlight which channel your controller is using for each stick/knob/switch input, not 
what control function you want that stick/knob/switch to perform. 

The Software Radio controls mixing, exponential, and other channel processing that a 
computer radio would normally perform.  The Software Radio determines the control 
function you want each stick/knob/switch setting to perform.  You will most likely 
want to adjust this differently for various aircraft.  For example, the mixing utilized for 
your glider will probably not be very useful on a jet. 

The Electronics options modify the servo properties (e.g., servo speed) as well as 
adjusting the input channels in the same way as the Channel Mapping… wizard.  
However, changes made using the Electronics options only apply to the particular 
aircraft that you are editing.  Use the Electronics options only when you want to edit a specific servo 
property (like servo speed) or if for some reason you need to reassign an input channel for one aircraft 
only.  In most cases, you should not need to do the latter.  Instead, you should normally 
use the software radio to configure control outputs. 

A good rule of thumb:  if a setting will not be the same for every aircraft, you should not try to 
implement the setting by using the Channel Mapping… menu item.  Instead, adjust the Software 
Radio.
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Events Menu 
Challenge your flying skills by competing in events, by yourself, or join others online. 

n event is an organized flying contest with a set of rules.  RealFlight G4 
supports five types of events: Autorotation/Deadstick, Free Style, Limbo, 
Pylon Racing and Spot Landing.  You can participate in these events by 
yourself or compete with other RealFlight G4 users over the internet. 

To participate in an event alone, all you have to do is start the event.  RealFlight G4 
does the rest. 

If you want to compete with other RealFlight G4 users, you must first start a 
multiplayer session (or join an existing one). See the Multiplayer chapter for additional 
information on how to do so. 

When all of the participants have joined the session, the session host will start the event.  
This enrolls every member of the multiplayer session in the Event.  If any multiplayer 
session members want to leave the event, they can do so while remaining a part of the 
multiplayer session. 

RealFlight G4 limits you to running only one event at a time.  This rule also applies to 
multiplayer sessions. 

The Events menu accesses all events, and event-related options.  When you open the 
menu, the items are: 

Chapter

8
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• Autorotation/Deadstick 

• Freestyle 

• Limbo 

• Pylon Racing 

• Spot Landing 

• Options… 

• End Current Event 

• Forfeit Turn 

Some of these items may be grayed out if they do not apply to the current situation.  
For example, you cannot end the current event unless an event is already running.  
Consequently, the End Current Event menu item will be grayed out. 
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Autorotation/Deadstick 
 
The Autorotation/Deadstick event is similar to the Spot Landing event mentioned 
below.  This event requires that you make a landing with all power off. 

 

The goal of this event is to land the airplane, or autorotate the helicopter, into the 
marked zones.  The various landing zones have different point values assigned to them.  
Generally, the zones that are more difficult to target are awarded higher point values.  
If participating in a multiplayer event, the player with the highest points total at the end 
wins. 

It is possible to enable the software to “kill” the player’s engine when their aircraft 
passes a particular altitude. 

Selecting Your Name for the Event- 
If you have already entered a name in the Settings… menu item, this name will be 
utilized for single player and multiplayer events.  If you have not entered a name, please 
do so in the space provided when you select an event.  Click OK when completed. 

To select a different name for this event, click on the Simulation menu, followed by 
the Settings… menu item.  Next, click the Multiplayer name.  This brings up the 



 

 150

multiplayer options.  Click the value found next to the Pilot Name item.  Use the 
keyboard to input the name you wish to utilize for the events. 

Options- 
The Options… menu item adjusts the parameters and rules for each event.  To access 
the Options… menu item, click the Events menu followed by the Options… menu 
item.  Next, from the column on the left side, select the event that you wish to adjust.  
The selections that appear will depend upon the event selected.  This section examines 
the selections available for the Autorotation/Deadstick Landing Options. 

 

Zone Point Values- Zones A through E- 
The landing zones are divided into five segments.  In the default settings, each 
segment has a different point value assigned to it based upon degree of 
difficulty.  Zone A is the smallest, most difficult target.  Therefore, it offers the 
highest point value.  Zone B, which surrounds the center, offers the second 
highest points, followed by Zone C, D and E. 

To adjust the values of these points, click on the values in the column to the 
right of the respective Zone Points.  For example, to adjust the points for 
Zone A, click on the corresponding Value in the column next to Zone A.  
Enter the desired value directly from the keyboard or via the mouse wheel. 

Turns Per Event- 
This option determines the number of turns that each player is allotted per 
event.  When each player has taken the designated number of turns, the event 
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is over.  The only exception is if the host activates the Crash Eliminates Player 
setting.  In this case, the event will end if all of the players crash before they 
reach the turn limit. 

To adjust the number of turns, click on the corresponding value.  Enter the 
desired value directly from the keyboard or via the mouse wheel. 

Throttle cut altitude- 
As mentioned previously, in an Autorotation/Deadstick event, the host can set 
the rules so that the throttle is cut manually or automatically.  This section 
refers to the settings for a manual throttle cut.  For information on automatic 
throttle cuts, please see the Player Kills Engine section below. 

To adjust the altitude at which the throttle is cut, click on the corresponding 
value.  Enter the desired altitude value directly from the keyboard or via the 
mouse wheel. 

Time to Complete Turn (sec)- 
This is the amount of time allotted for each player to complete his or her turn. 

Note:  the countdown or timer is initiated at takeoff. 

To adjust the amount of time to complete the Event, click on the 
corresponding value.  Enter the desired value directly from the keyboard or via 
the mouse wheel. 

Target Scale- 
This option determines the size of the landing targets. 

To modify the size of the landing area, enter a number in the corresponding 
value column.  Enter the desired value directly from the keyboard or via the 
mouse wheel.  The size of the targets will scale proportionally. 

Crash Eliminates Player- 
This option determines whether a crash eliminates a player from the 
competition.  If No, the player will be able to continue his/her turn regardless 
of whether or not they have crashed.  If Yes, the event is over for them as 
soon as a crash occurs. 

To set Crash Eliminates Player option, click the value in the corresponding 
column.  From the pull-down list, select either Yes or No. 

Player Kills Engine- 
This option determines whether you want to cut off the engine manually or 
allow RealFlight G4 to do so for you.  If enabled, the player must manually kill 
the engine above the Throttle Cut Altitude.  RealFlight will display the engine 
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cut notification for you on-screen.  With automatic throttle cutting, RealFlight 
G4 will automatically cut the throttle as soon as the aircraft crosses the 
minimum altitude threshold.  Again, RealFlight will display the engine cut 
notification for you on-screen. 

To set Player Kills Engine option, click the value in the corresponding column.  
From the drop-down list, select either Yes (manual cut required) or No 
(automatic cut at altitude). 

 

Autorotation/Deadstick Instructions 
 
You can run an autorotation competition in either a single player or multiplayer 
environment. 

 

The person who starts the event decides upon the applicable rules and parameters.  For 
example, you can set: 

• The time allotment for each player’s turn. 

• How many turns each player receives. 
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• Whether a player’s engine is automatically or manually killed during a turn. 

• The altitude at which an engine must be killed. 

• The physical dimensions of the landing target. 

• Whether or not a crash automatically disqualifies a player. 

• Point values of the different zones within the landing target. 
 
RealFlight G4 automatically applies the rules you choose, and keeps track of scores.  
During the event, the announcer’s voice will guide you through each phase of the 
competition. 
 
Rules  
The Autorotation/Deadstick course consists of a target: 

The object of the Autorotation/Deadstick event is to fly your model over the target, 
kill the engine, then touch down as close as possible to the center of the target.  Players 
take turns making landing attempts.  When your turn comes, you will normally takeoff, 
gain altitude until you are above the minimum Throttle Cut Altitude, fly towards the 
target, and then kill your engine and autorotate or glide to the ground. 

If the host so decides, you must kill your engine before dropping below the minimum 
altitude to kill engine.  Alternatively, the host can decide that your engine will 
automatically shut off when you pass below this altitude.  The host must also decide on 
the minimum Throttle Cut Altitude. 

A “touch down” occurs when any part of your airplane or helicopter touches ground.  
Each touch down is marked with an ‘X’ on the spot at which the aircraft landed. 

Please note:  this is not necessarily the point at which the aircraft stopped moving. 

An “attempt” means you have passed below the minimum altitude to kill your engine.  
Once your engine is disabled, you cannot reactivate it until your turn expires.  
Additionally, you must land successfully (without crashing) to receive any points for 
your attempt. 

Furthermore, you must complete your landing before your turn time expires.  If you do 
not touch down in time, you will lose your turn. 

The points you receive during a turn are dependent upon where you touch down.  
Within the target, each colored zone has a different point value.  Normally, the closer 
to the center you land, the more points you will receive.  Your touch down point is the 
point on the ground directly below the center of your aircraft, no matter what part of 
your aircraft touches first. 
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The event continues until the players complete all of their turns, all of the players are 
disqualified (usually by crashing), or everyone has left the event.  The player with the 
highest point total at the end of the event is the winner. 

Events Viewport Display Box- 
During the event, a situational screen will appear on your display.  This screen serves 
several purposes:  it indicates the player’s name, tracks the amount of time remaining to 
complete the event, and indicates the remaining altitude before the engine is cut. 

If you do not wish to view this information, double-click on the title bar of the display 
box.  This will hide the information.  To view it once again, simply double-click the 
title bar again. 

To reveal the statistics for the event, click the arrow button in the upper right corner of 
the box.  Click the arrow button one more time to hide this information. 

To resize the viewport, position the cursor over the lower right corner of the 
viewport’s frame.  Using the mouse, drag the frame according to your wishes.  If you 
drag it downward, the vertical size of the viewport will increase.  Dragging the frame to 
the right or left will increase/decrease the width of the viewport respectively. 

Clicking on the ‘X’ in the title tab of the viewport will close the viewport. 

 

Freestyle 
 
RealFlight G4’s Freestyle event lets you make the rules.  When you start a Freestyle 
event, RealFlight G4 will allot every player a set of turns.  Each player’s turn ends when 
that player’s time expires (or if the player crashes).  When this occurs, the next player’s 
turn begins.  What players do during their respective turns is completely up to the 
participants.  We’ve included some possible freestyle examples below.  
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Whatever activity you pick, RealFlight will see that each player receives a timed turn.  
You can use freestyle with any aircraft (airplanes or helis). 

Selecting Your Name For the Event 
If you have already entered a name in the Settings… menu item, this name will be 
utilized for single player and multiplayer events.  If you have not entered a name, please 
do so in the space provided when you select an event.  Click OK when completed. 

To select a different name for this event, click on the Simulation menu, followed by 
the Settings… menu item.  Next, click the Multiplayer name.  This will bring up the 
multiplayer options.  Click the value found next to the Pilot Name item.  Use the 
keyboard to input the name you wish to utilize for the events. 

Options 
As the name suggests, the Options… menu item is used to adjust the parameters and 
rules for each of the events.  The Autorotation/Deadstick Event section discusses general 
notes for this option.  This section examines the selections available for the Freestyle 
options. 
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Time to Complete Turn (sec)- 
This is the amount of time allotted for players to complete their turn. 

Please note:  the time begins at takeoff. 

To adjust the amount of time to complete the event, click on the 
corresponding value.  Enter the desired value directly from the keyboard or via 
the mouse wheel. 

Turns Per Event- 
This option determines the number of turns that will be allotted to a player for 
the event.  The event is over when each player has taken this number of turns, 
or sooner if the host activates the Crash Eliminates Player option and a crash 
occurs. 

To adjust the number of turns, click on the corresponding value.  Enter the 
desired value directly from the keyboard or via the mouse wheel. 

Crash Eliminates Player- 
This option determines whether a crash eliminates a player from the 
competition.  If No, the player will be able to continue his/her turn regardless 
of whether or not they’ve crashed.  If Yes, the event is over for them as soon 
as they crash. 
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To determine whether a crash eliminates a player, click the value in the 
corresponding column.  From the pull-down list, select either Yes or No. 

 

Freestyle Instructions 
 
You will usually want to use Freestyle in a multiplayer environment, but it works in 
single player mode as well. 

 

Before you start this event, you will ordinarily decide what the participants must do.  
You may just want to use the event to give everyone an equal chance to showcase his 
or her aerobatic skills.  This will prevent you from worrying about your scoring.  If you 
want to have a competition, we suggest that before you begin the event: 

• Everyone should agree on the rules. 

• The host may need to edit the airport to add any equipment (pylons, runways, 
fences, obstacle rings, limbo poles, etc.) that you will need for the event. 

• Everyone should agree how the event will be judged.  You could appoint one 
player to decide on a score for every other player, or have everyone in your session 
vote on the best maneuver, etc. 
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The person who starts the Event (multiplayer session host) can pick: 

• How much time each player is allotted per turn 

• How many turns each player receives, and 

• Whether a player who crashes is automatically disqualified 
 
We emphasize, the only limit on the freestyle event is your imagination.  A few examples of what 
you might wish to do: 

• Touch and Go.  Appoint one partner to count runway touches, the contestant with 
the most touches in a turn wins. 

• Aerobatics.  Players use their turns to perform any stunt they want.  At the end, 
everyone votes on the best stunt. 

• Obstacle course.  Set up a long obstacle (table, etc.) close to the ground and take 
turns flying under it; land or takeoff from ramps, circle around pylons, etc. 

 
It does not have to be a contest.  You might all just want to take an equal turn at using 
the runway (takeoff, land on alternate turns). 
 
Events Viewport Display Box- 
During the event, a situational screen will appear on your display.  General notes on 
this display were discussed in the Autorotation/Deadstick event section. 

 

Limbo 
 
A limbo event is a contest of piloting skill and courage.  Players attempt to maneuver 
their aircraft under a horizontal bar suspended across two vertical bars.  After each 
successive pass, the bar is lowered.  The event continues until only one pilot remains. 
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Selecting Your Name For the Event- 
If you have already entered a name in the Settings… menu item, this name will be 
utilized for single player and multiplayer events.  If you have not entered a name, please 
do so in the space provided when you select an event.  Click OK when completed. 

To select a different name for this event, click on the Simulation menu, followed by 
the Settings… menu item.  Next, click the Multiplayer name.  This will bring up the 
multiplayer options.  Click the value found next to the Pilot Name item.  Use the 
keyboard to input the name you wish to utilize for the events. 

Options- 
The Options… menu item is used to adjust the parameters and rules for each of the 
Events.  See the Autorotation/Deadstick section for general notes about this screen.  This 
section examines the specific selections available for the Limbo options. 
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Minimum Bar Height- 
This setting determines the lowest height that the bar will reach during the 
Event. 

To adjust the Minimum Bar Height, click on the corresponding value.  Enter 
the desired value directly from the keyboard or via the mouse wheel. 

Maximum Bar Height- 
This setting determines the highest setting (starting value) that the bar will 
reach during the event. 

To adjust the Maximum Bar Height, click on the corresponding value.  Enter 
the desired value directly from the keyboard or via the mouse wheel. 

Distance to Drop Bar each Round- 
After a participant successfully passes under the limbo bar, on their next 
attempt the bar will lower by the amount indicated in this setting. 

To adjust the distance by which the bar will be lowered each round, click on 
the corresponding value.  Enter the desired value directly from the keyboard or 
via the mouse wheel. 

Commit Line Distance- 
This indicates the distance between the commitment lines and the limbo bar.  
There is a commitment line on either side of the limbo bar and participants 
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may approach from either side.  These lines detect an attempted pass at the 
limbo bar. 

To adjust the distance, click on the corresponding value.  Enter the desired 
value directly from the keyboard or via the mouse wheel. 

Distance Between Poles- 
The value entered here indicates the distance between the two vertical poles 
that support the limbo bar.  The wider the space between the poles, the easier 
it is to pass through the gate, so to speak. 

To adjust the distance, click on the corresponding value.  Enter the desired 
value directly from the keyboard or via the mouse wheel. 

Time to Complete Turn (sec)- 
This is the amount of time allotted for each player to complete his or her turn. 

Please note:  the countdown or timer is initiated at takeoff. 

To adjust the amount of time to complete the Event, click on the 
corresponding value.  Enter the desired value directly from the keyboard or via 
the mouse wheel. 

Attempts Per Turn- 
This value indicates the number of attempts that each pilot is allotted at any 
given height of the limbo bar before being eliminated for that turn. 

To adjust the number of attempts, click on the corresponding value.  Enter the 
desired value directly from the keyboard or via the mouse wheel. 

Turns Per Event- 
This option determines the number of turns per player for this event.  When 
this number is reached, the event is over.  If the host activates the Crash 
Eliminates Player option, however, the event may end sooner. 

To adjust the number of turns, click on the corresponding value.  Enter the 
desired value directly from the keyboard or via the mouse wheel. 

Crash Eliminates Player- 
This option is used to determine whether a crash eliminates the player from 
the competition.  If No, the player will be able to continue his/her turn 
regardless of whether or not they have crashed.  If Yes, the event is over for 
them as soon as a crash occurs. 

To determine whether or not a crash eliminates a player, click the value in the 
corresponding column.  From the drop-down list, select either Yes or No. 
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Limbo Instructions 
 
A limbo competition can be run in either a single player or multiplayer environment. 

The limbo course consists of a limbo pole, and two attempt lines (also called 
commitment lines), one on each side of the limbo pole. 

 

The object of limbo is to fly an aircraft past the attempt line, then under the limbo bar, 
in the time allowed.  Players take turns attempting to fly under the bar.  When your 
turn comes, you will normally takeoff, circle back towards the limbo pole, then pass 
across the attempt line and under the bar, then land.  If you successfully fly under the 
bar, the bar height will be lowered prior to your next turn. 

An “attempt” means you have crossed the attempt line, approaching the limbo bar.  
You can make multiple attempts, if necessary, during a turn. 

You have anywhere from 10 seconds to five minutes between the moment you first lift 
off and the moment you successfully pass under the bar.  If you fail to make it under 
the bar in time, you lose your turn.  (Before the event begins, the host decides the exact 
time limit.) 
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You can approach the limbo bar from either direction (i.e., you can cross either 
attempt line).  For an attempt to count, you must be approaching the limbo bar when 
you cross an attempt line.  Your aircraft must be airborne when it crosses the attempt 
line and when it passes under the bar (i.e., if you taxi, your attempt will not count). 

The event continues until each player has made it under the lowest bar height, or has 
been disqualified (usually by crashing), or has left the event.  

The player with the highest score wins.  Your score for each successful turn is: 

(time between first liftoff and successful pass) X (height cleared) / 100 

Notice that you will achieve or earn the highest score by passing under the bar as soon 
as possible after takeoff. 

If you did not make it under the bar, your score for that turn is zero. 

Events Viewport Display Box- 
During the event, a situational screen will appear on your display.  This screen serves 
several purposes.  General notes on the functionality for this window were discussed in 
the Autorotation/Deadstick event section. 

 

Pylon Racing 
 
In pylon racing, pilots race their planes around a closed course.  Pylon Racing 
challenges the pilots’ nerves and skills as they attempt to round the pylons, avoid mid-
air collisions, and finish first, without cutting any pylons. 
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Selecting Your Name For the Event- 
If you have already entered a name in the Settings… menu item, this name will be 
utilized for single player and multiplayer events.  If you have not entered a name, please 
do so in the space provided when you select an event.  Click OK when completed. 

To select a different name for this event, click on the Simulation menu, followed by 
the Settings… menu item.  Next, click the Multiplayer name.  This will bring up the 
multiplayer options.  Click the value found next to the Pilot Name item.  Use the 
keyboard to input the name you wish to utilize for the events. 

Options 
As the name suggests, the Options… menu item is used to adjust the parameters and 
rules for each of the Events.  To access the Options… menu item, click the Events 
menu followed by the Options… menu item.  Next, from the left hand column, click 
on the event for which you wish to adjust the Options….  The selections that appear 
will be dependent upon the event selected.  This section examines the selections 
available for the Pylon Racing Options. 
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Laps to complete- 
This value determines the number of laps that each participant must complete 
in the event.  The person who completes the laps in the shortest amount of 
time (after penalties) is the winner. 

To adjust the number of laps, click on the corresponding value.  Enter the 
desired value directly from the keyboard or via the mouse wheel. 

Cuts Allowed- 
This setting dictates the number of cuts (passes inside a pylon) that a racer is 
allowed before being eliminated from the event. 

To adjust the number of allowable cuts, click on the corresponding value.  
Enter the desired value directly from the keyboard or via the mouse wheel. 

Cut Penalty (sec)- 
This option determines the time penalty that a player receives for each cut they 
make during a race.  If the player exceeds the number of allowable cuts, they 
are eliminated from the race. 

To adjust the penalty seconds per cut, click on the corresponding value.  Enter 
the desired value directly from the keyboard or via the mouse wheel. 
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Three Pylons on Course- 
This setting determines whether the course is a three-pylon course or a two-
pylon course.  If Yes is selected, the course is a three-pylon course.  If No, the 
course is a two-pylon course. 

To set this option, click the value in the corresponding column.  From the 
pull-down list, select either Yes (three pylon course) or No (two pylon course). 

Threshold Rules- 
In threshold racing, the planes do not actually have to go around the pylon.  
Rather, they only have to break the plane of the pylon.  This option is only 
enabled for two pylon courses.  It is grayed out (not applicable) on three pylon 
courses. 

To determine whether the Threshold Rules will be utilized, click the value in 
the corresponding column.  From the pull-down list, select either Yes or No. 

Distance between pylons 1 and 2- 
If you have selected a two-pylon course, this option indicates the distance 
between the two pylons.  Increasing the value places the pylons farther apart. 

To adjust the distance, click on the corresponding value.  Enter the desired 
value directly from the keyboard or via the mouse wheel. 

Distance to pylon 1- 
This is the distance from the starting point to pylon number 1.  This option is 
only applicable to three-pylon courses. 

To adjust the distance, click on the corresponding value.  Enter the desired 
value directly from the keyboard or via the mouse wheel. 

Distance between pylons 2 and 3- 
If you have selected a three-pylon course, this option indicates the distance 
between the pylons two and three.  Increasing the value places the pylons 
farther apart. 

To adjust the distance, click on the corresponding value.  Enter the desired 
value directly from the keyboard or via the mouse wheel. 

 

Pylon Racing Instructions 
 
You can run a pylon race in either a single player or multiplayer environment. 
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The person who starts the event (the host) decides upon the applicable rules and 
parameters.  For example, the host can set: 

• How many pylons mark the course (two or three). 

• Regular or threshold-style racing (two-pylon races only). 

• The number of laps in the race. 

• The distances between pylons. 
 
RealFlight G4 automatically applies the rules you choose, and keeps track of scores.  
During the event, an announcer’s voice will guide you through each phase of the 
competition. 

Pylon Racing Rules- 
A pylon-racing course consists of two or three pylons.  Here is an example of a three-
pylon course: 

For both two-pylon and three-pylon races, the object is to takeoff and circle the pylons 
(without “cutting”) in the shortest amount of time.  A pylon race usually has two or 
more laps.  All racers start simultaneously.  The race continues until each player is 
either finished or disqualified (usually by cutting or crashing). 



 

 168

All players start at the same point on the runway.  When you hear the horn sound, 
takeoff and start the race. 

In pylon racing, you always circle the pylons counterclockwise viewed from above—
that is, when you come to a pylon you always turn left.  As you approach each pylon, 
you will hear a voice telling you when to start your turn.  When you have made a 
successful turn, you will hear a brief tone. 

“Cutting” is illegal.  The first time you cut during a race, you are penalized one lap.  
The second time you cut, you are disqualified.  To avoid being called for a cut, your 
entire aircraft must normally go completely around each pylon. 

Exception:  in a two-pylon style course, you can choose to use threshold-racing rules.  
In threshold racing, your aircraft only has to “break the plane” of the pylon to get 
credit for a legal turn.  This allows pilots to find independent race lines, which may 
reduce collisions during a race.  Before the race begins, the host chooses whether the 
race will follow regular or threshold rules. 

The pilot who finishes the required number of laps in the shortest amount of time wins 
the race. 

Events Viewport Display Box 
During the Event, a situational screen will appear on your display.  This screen serves 
several purposes.  General notes on this screen were discussed in the 
Autorotation/Deadstick event section. 

 

Spot Landing 
 
In a Spot Landing event, pilots take turns trying to touch their aircraft down within 
marked zones.  Generally, the zones that are more difficult to target have higher point 
values.  In a multiplayer event, the player with the highest points total wins. 
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Selecting Your Name For the Event- 
To select a different name for this event, click on the Simulation menu, followed by 
the Settings… menu item.  Next, click the Multiplayer name.  This will bring up the 
multiplayer options.  Click the value found next to the Pilot Name item.  Use the 
keyboard to input the name you wish to utilize for the events. 

Options- 
As the name suggests, the Options… menu item adjusts the parameters and rules for 
each of the Events.  To access the Options… menu item, click the Events menu 
followed by the Options… menu item.  Click on the event, located in the left column 
that you wish to adjust.  The options that appear are dependent upon the event 
selected.  This section discusses the selections available for the Spot Landing options. 
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Zone Point Values- Zones A through E 
The landing zones are divided into five segments.  In the default settings, each 
segment has a different point value assigned to it based upon degree of 
difficulty.  Zone A is the most difficult to hit.  Therefore, it offers the highest 
point value.  Zone B, which surrounds the center, offers the second highest 
points, followed by Zone C, D and E. 

To adjust the point values of the different zones, click on the values in the 
column to the right of the respective Zone Points.  For example, to adjust the 
points for Zone A, click on the corresponding value in the column next to 
Zone A.  Enter the desired value directly from the keyboard or via the mouse 
wheel. 

Target Scale- 
This option determines the size of the landing targets.  To increase the size of 
the landing area, enter a larger number in the corresponding value column.  
The target size will scale proportionally. 

Time to Complete Turn (sec)- 
This is the amount of time allotted for players to complete their turn. 

Please note:  this time begins at takeoff. 
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To adjust the amount of time to complete the event, click on the 
corresponding value.  Enter the desired value directly from the keyboard or via 
the mouse wheel. 

Turns Per Event- 
This option determines the number of turns allotted to the player for the 
Event.  The event is over when each player has completed the number of turns 
specified.  If the Crash Eliminates Players option is enabled, the event can also 
end when all of the players have been eliminated due to crashing. 

To adjust the number of turns, click on the corresponding value.  Enter the 
desired value directly from the keyboard or via the mouse wheel.  

Crash Eliminates Players- 
This option determines whether a crash eliminates a player from the 
competition.  If No, players will be able to continue their turns regardless of 
whether or not they crash.  If Yes, the event is over for them as soon as they 
crash. 

To determine whether a crash eliminates the player, click the value in the 
corresponding column.  From the pull-down list, select either Yes or No. 

 

Spot Landing Instructions 
 
A spot landing competition can take place in either a single player or multiplayer 
environment. 
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The person who starts the event (the host) is responsible for selecting the rules.  For 
example, you can set: 

• How much time each player receives per turn. 

• How many turns allowed per player. 

• The physical dimensions of the landing target. 

• Whether a crash automatically disqualifies the player. 

• Point values of the different zones within the landing target. 
 
RealFlight G4 automatically applies the rules you choose, and keeps track of scores.  
During the event, the announcer’s voice will guide you through each phase of the 
competition. 

Rules- 
The object is to touch down as close as possible to the center of the target.  Players 
take turns making landing attempts.  When your turn comes, you will normally takeoff, 
gain altitude and then fly towards the target on a landing approach. 
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A “touch down” occurs when any part of your airplane or helicopter touches the 
ground.  A large, visible ‘X’ marks each touch down on the spot where the aircraft 
landed. 

Please note:  this is not necessarily the point at which the aircraft stopped moving. 

Furthermore, you must complete your landing before time expires, thus ending your 
turn.  If you do not touch down in time, you lose your turn. 

The points you receive during a turn are dependent upon where you touch down.  
Within the target, each colored zone has a different point value.  Normally, the closer 
to the center you land, the more points you receive.  Your touch down point is the 
point on the ground directly below the center of your aircraft, no matter what part of 
your aircraft touches first. 

The event continues until each player has completed all of his or her turns, or has been 
disqualified (usually by crashing), or has left the event.  The player with the highest 
point total is the winner. 

You also have a limit on how many landing attempts you can make during your turn.  
The host sets this limit at the start of the event. 

You can approach the target from either direction (i.e., you can cross either attempt 
line).  For an attempt to count, you must be approaching the target when you cross an 
attempt line.  The aircraft must be airborne when it crosses the attempt line (i.e., if you 
taxi, the attempt will not count). 

You can only touch down once per turn, so if it looks like you may miss the target, pull 
up, circle around, and try again. 

The event continues until the players have completed all of their turns, all of the players 
have been disqualified (usually by crashing), or everyone has left the event. 

The player with the highest total score wins. 

Events Viewport Display Box- 
During the event, a situational screen will appear on your display.  The 
Autorotation/Deadstick event section provides general notes on this display box. 

 

Options 
 
The Options… menu item allows you to determine the various settings and parameters 
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for the respective events.  The options available to you are dependent upon the Event 
selected. 

To access the Options… menu item, click on the Events menu followed by the 
Options… menu item.  Next, select the Event for which you would like to view the 
Options….  For further information as to the Options… available for each event, see 
the applicable event as discussed previously. 

 

End Current Event 
 
This menu item immediately ends the current event.  If there are no events in progress, 
this menu item is grayed out.  If you are in a multiplayer session and are not the person 
hosting this session, the option is also grayed out. 
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Forfeit Turn 
 
This item allows you to forfeit one turn.  If you are a multiplayer participant, all other 
pilots will take their turns before you can participate again. 

 

This item is grayed out if you are playing an event where players do not take turns (e.g. 
Pylon Racing). 
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Multiplayer Menu 
Fly with friends, at the same computer, or over the internet. 

he Multiplayer option allows you to fly with others.  In fact, you are able to 
share the skies with up to seven additional pilots.  These other pilots can be 
across the street, around the block, or around the world! 

There are two ways to link up with the additional pilots; via a LAN (Local Area 
Network), or over the internet.  In order to do so, you will need a TCP/IP connection, 
either through your LAN or an ISP (Internet Service Provider). 

Every session requires someone to serve as host.  The host initiates the multiplayer 
session.  When the Host starts a session, other participants may join in. 

The Multiplayer menu allows you to access a variety of multiplayer-related features, 
functions and options.  Clicking the Multiplayer menu brings forth a pull-down menu, 
which will look similar to the following screen shot: 
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• Host… 

• Join… 

• Disconnect 

• Boot Player… 

• Publish Hosting Information 

• Enter MultiMode 

Some of these items will be grayed out if they do not apply to the current situation.  
For example, you cannot disconnect unless you are currently connected.  As such, the 
Disconnect menu item is grayed out unless you are in a multiplayer session. 

When you participate in multiplayer sessions, the menu commands you will access 
depend on whether you are the host or whether you opt to join someone else’s session.  
These commands also depend upon whether you already have a specific session you 
want to join. 

Depending on what options the participants utilize, it is possible to have a private 
session that is only open to players who know the host’s IP address. 



 

 179

Please note:  a computer’s IP address is its internet “postal code”.  It tells other 
computers on the internet how to contact that computer.  The following sections will 
explain more about IP addresses as necessary. 

It is also possible to participate in a public session using our list server.  The list server 
is a publicly available list of open RealFlight G4 sessions.  Currently we provide the list 
server to all RealFlight G4 owners, free of charge.  The list server allows you to 
participate in multiplayer sessions with other RealFlight G4 users anywhere in the 
world. 

IMPORTANT INFORMATION ABOUT THE LIST SERVER:  At the time 
of this writing we are providing the list server service on a trial basis.  This 
service may be modified, interrupted or cancelled at any time without notice.  
In particular, we make no guarantee about the reliability of this service.  To use 
this service you must register your product and may need to obtain product 
updates.  Inclusion of this manual on your RealFlight CD-ROM does not imply 
that this service will be available at the time you purchase this product.  
Moreover, we reserve the right to bar any individual user, or all users at 
individual IP addresses or domains, from using the list server at our discretion.  
Abusive behavior, for example, will not be tolerated. 

 

Chatting 
 
During Multiplayer sessions, you may want to chat with other participants.  Doing so is 
as simple as typing a message much like popular instant messenger programs. 

To send a chat message, press the Enter key to bring up the Chat field at the bottom 
of the screen.  Next, using the keyboard, type the message you wish to send.  Press the 
Enter key again on the keyboard to send the message. 

Please note:  all messages are viewable by all participants.  RealFlight G4 does not offer 
private chat. 

Any messages received from other participants will appear at the bottom of the screen. 

 

Host 
 
Every multiplayer session requires one participant to function as the host.  If you are 
the host, you will be the one who starts the session.  When you leave the session one of 
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the remaining participants automatically assumes the role of Host.  The host is also the 
one who starts and ends the events (Limbo, Pylon Racing, etc.). 

 

Once you have started the session, other players may join in as they wish. 

If you opt to broadcast the session to the list server, the session is known as a public 
session.  The session will be open to all G4 owners searching for multiplayer events. 

If you wish to keep the session private, only those participants to whom you have 
provided your IP address will be able to join. 

The procedures for starting public and private sessions are very similar.  In order to 
join your session, the participants will usually need to know the IP (Internet Protocol) 
address of your computer.  The exception is if you are holding the session over a LAN, 
in which case the other players do not need to know your IP address.  For a public 
session, your partners can retrieve your IP from the list server.  For a private session, 
you must provide the IP address directly to the desired participants.  When the session 
starts, RealFlight G4 will display your IP in the lower left corner of the main display. 

To access the Host… menu item, click on the Multiplayer menu followed by the 
Host… menu item. 
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Host Information- 
The Host Information allows you the ability to name your multiplayer session.  You 
can also choose the maximum number of pilots and whether or not you wish to make 
your multiplayer session public or private. 

 

Session Name- 
Using the keyboard, enter the name of the session that you will be hosting. 

Please note:  this is the name of your session, not necessarily your personal 
name.  In fact, you might find it useful to use a descriptive name such as “3D 
Fun Fly.”  This is particularly useful when other participants are searching for a 
likely session to join. 

Max Players- 
To adjust the maximum number of players allowed in your session, click the 
down arrow.  Enter the number directly from your keyboard or use the mouse 
wheel. 

Currently, a multiplayer session may not have more than eight members.  If the 
host computer is somewhat slow or has a poor internet connection, you may 
want to limit the number of participants. 

Optional Port Number- 
For users that are behind firewalls, you may want to use a port other than the 
default port (which is 2302).  Most users should leave this field blank. 

Broadcast to the List Server- 
Clicking this option allows your session to be posted on the list server.  This 
allows other RealFlight G4 users to join your session.  This is a good option if 
you are looking for new (or additional) partners to fly with.  If you check this 
box, you will be prompted for session information (see next section). 

If you leave this box unchecked, your session will not be posted on our list 
server and you will have a private session.  You will have to directly provide 
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your IP address to your multiplayer partners (through phone, email, chat room, 
or whatever means you wish).  This is a good option if you want to limit your 
session to a private group of friends. 

If you do not want to broadcast your session information now, you can do so 
after the start of the session (see section pertaining to Publish Hosting 
Information on page 186).  

Finally, please remember that at the time of this writing, we are providing the 
list server on a trial basis only.  This service may be modified, interrupted or 
discontinued at any time without notice. 

 

Join 
 
This option allows you to participate in a Multiplayer session without being the Host of 
the session yourself. 

 

To access the Join… menu item, click on the Multiplayer menu followed by the 
Join… menu item. 
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Before you can join a session, you will need two things: 

• A network connection and 

• The IP address of the session Host (unless the session is taking place over a LAN 
[Local Area Network]). 

 
You can get the IP address directly from the Host (in the case of a private session), or 
from our list server (in the case of a public session). 

Join Session- 
This dialog allows you to select the multiplayer session that you wish to join.  It also 
provides you with a variety of information pertaining to the various sessions available 
to you. 

 

Search Function- 
The Search function checks two distinct areas for multiplayer sessions.  
RealFlight G4 (at your discretion) will search the list server and the Local 
Network for multiplayer sessions. 

To determine the Search area, click the down arrow next to the Start button.  
This activates the pull-down selections.  Click on the location that you wish to 
search. 

After making your selection, click the Start button to begin the search.  When 
the search completes, the respective sessions and information appear in the 
dialog above.  To select one of these sessions, click on the respective session 
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and then click OK.  Alternatively, you may double-click on the Session Name 
to join. 

Note:  if you are using an updated version of Windows XP (Service Pack 2 or 
later), you may have Windows Firewall installed and running.  If this is the case, 
Windows Firewall will pop up a warning dialog (similar to that shown below) 
the first time you use the Search function.  You must select the Unblock 
option in order to allow RealFlight G4 to continue searching. 

Session Name- 
The Session Name column displays the name of all available sessions.  If you 
have not searched (and found) a session, or entered an IP address, the Session 
Name will remain blank. 

Host- 
This column shows the IP address of the host computer.  If you have accessed 
the address via the Search function, this information is automatically filled in 
for you when you select the session.  If you participate in a multiplayer session 
via a LAN, you do not need to fill in the IP address.  If you participate in a 
private session, fill in the IP address here.  When completed, click OK to 
proceed. 

Port- 
This information is important if you are attempting to participate in a 
multiplayer session and the computer is located behind a firewall or NAT.  The 
Port Number will route your computer’s data through the firewall.  It is 
imperative that this port number matches the port number of the host. 

Players- 
This column shows the users how many players are participating in a given 
multiplayer session.  The host determines the number of allowable participants. 

Latency- 
Latency is the amount of time it takes a packet of information to travel from its 
source to the destination.  The larger the number, the slower the information 
travels.  High latency can result in sluggishness and “lag” while running the 
simulation.  As such, you will want to avoid sessions where the latency number 
is high. 

 

Disconnect… 
 
This menu item is used to disconnect from, or exit, the multiplayer session. 
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To access the Disconnect… menu item, click on the Multiplayer menu followed by 
the Disconnect… menu item. 

Please note:  if you are not currently participating in a multiplayer session, this item will 
be grayed out and will not be accessible. 

 

Boot Player… 
 
This menu item is used to drop a participant from a multiplayer session.  It is only 
available if you are the Host of the session.  Otherwise, this item is grayed out and 
inaccessible. 
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To access the Boot Player… menu item, click on the Multiplayer menu followed by 
the Boot Player… menu item.  

The booted player will receive an on-screen message advising him/her that the host 
has booted (removed) them from the session. 

 

Publish Hosting Information 
 
You can make your session public (placed on the list server) when you first start the 
session.  Alternatively, you can do this while the session is in progress by selecting this 
menu item.  When you click OK, RealFlight G4 publishes your session information to 
the list server, where everyone can see it. 
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Please note:  at the time of this writing, we are providing the list server on a trial basis 
only.  This service may be modified, interrupted or discontinued at any time without 
notice. 

 

Enter MultiMode 
 
MultiMode allows you to fly with another pilot on the same PC, with each pilot 
controlling his or her own aircraft.  This feature is ideal for offering personal flight 
instruction, practicing formation flights, or simply for chasing one another across the 
skies. 
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To access the MultiMode menu item, click on the Multiplayer menu followed by the 
MultiMode menu item. 
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MultiMode will split the screen either horizontally (default) or vertically.  You can 
change this options in the Settings window.  Simply click the Simulation menu, 
followed by Settings.  On the left side of the Settings screen that appears, choose 
Multiplayer.  On the right, you can adjust the Multimode Screen Layout to 
Horizontal or Vertical. 

All options available in RealFlight are also available in MultiMode.  The difference is 
most will function on the half of the screen that currently is active.  To determine 
which half has the focus or is active, look for the yellow outline.  To change focus, click 
the half that doesn’t have the yellow outline.  You’ll notice the focus change when you 
do so. 

For example, if you are flying in MultiMode with a horizontally split screen, you might 
notice that the yellow outline is around the type half.  If you want to change the aircraft 
for the person flying on the bottom half of the screen, first click that half of the 
window so it has the focus or is the active screen.  Select an aircraft following the 
normal procedure. 

To exit MultiMode, select Exit MultiMode menu item under the Multiplayer main 
menu.
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Recordings Menu 
Save and playback RealFlight memories. 

he Recordings menu is used to start and stop recordings to assist you in your 
R/C ventures.  RealFlight G4 also allows you to record your flights for later 
playback -- complete with audio voiceovers.  You can even share your flights 
with friends and fellow pilots. 

 

Menu options that are available for Recordings are: 

• Start/Stop Recording 
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• Open Recording 

• Record Microphone Input 

• Recordings MRU 

 

Start Recording 
 
Click on the Recording menu followed by the Start Recording menu item.  
RealFlight G4 will start recording your flight immediately.  An on-screen message will 
confirm that the recording has started. 

 

Alternatively, you may also press the keyboard’s ‘R’ key to start a recording. 

RealFlight will continue recording your flight until you select the Stop Recording 
menu item or press ‘R’ again to stop recording. 
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Stop Recording 
 
The Stop Recording menu item is not visible until the Start Recording menu item 
activates.  To stop the recording of your flight at any time, click the Recording menu 
title, followed by the Stop Recording option.  RealFlight G4 will stop recording at this 
time.  RealFlight G4 automatically saves all recordings for playback later.  For 
information on how to delete a recording, please see the Open Recording… section 
which follows. 

Alternatively, you may also press the keyboard’s ‘R’ key to stop recording. 

When RealFlight G4 stops recording, an on-screen message appears which indicates 
the default name of the recording that has just been completed.  For information on 
how to change the name of a recording, please see the Open Recording… section 
which follows. 

 

Open Recording… 
 
This menu item allows you to access the recording files.  It also allows you to perform 
a variety of modifications to the files such as renaming them or deleting them.  To 
access the recordings, click the Recording menu title, followed by the Open 
Recording… menu item. 
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To open a recording, click on the file name.  Next, click on the Open button.  
Alternatively, you may double-click on the file.  Regardless of which method you utilize, 
this will start RealFlight’s Playback Gadget.  For more information on the Playback 
Gadget, please refer to the information below. 

If you wish to rename the recording, simply right click on the respective Recording, 
select rename from the drop-down menu and rename the file. 

To delete a recording, right click on the Recording file and select Delete from the pull-
down list. 

Playback Gadget- 
When you open a recording, RealFlight G4’s playback gadget appears on the screen.  
This gadget allows you to control the playback of the recordings using simple mouse 
commands.  It features DVD-like controls that start, stop, or pause the playback.  It is 
also possible to modify the playback gadget. 
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If you do not wish to view the playback information, double-click the title bar of the 
display box.  This will hide the information.  To view it once again, simply double-click 
the title bar again. 

To resize the playback gadget display, position the cursor over the lower right corner of 
the frame.  Using the mouse drag the frame according to your wishes.  Dragging the 
frame to the right or left increases or decreases the width of the viewport, respectively. 

Clicking on the ‘X’ in the viewport’s title tab removes it from the screen and exits the 
playback. 

Loop Play- 
The arrows that forms a circle causes the recording to loop (i.e., play 
continuously).  The continuous loop is activated when the arrows are 
illuminated.  To stop the looping, click on the loop button again. 

  

Look at Recording- 
Click on the ‘eye’ to look at the respective Recording.  This causes the camera 
to treat the recording as its target object, rather than your aircraft.  If you have 
multiple recordings playing, choose the ‘eye’ of the Recording you wish to view. 

  

Left/Right Arrows- 
The left and right arrows rewind (left) or fast forward (right) the recording.  
Alternatively, you may click on the position indicator, hold the mouse button 
and drag the indicator to the desired position. 
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Playback/Pause- 
If the recording is paused, the playback button will be the single arrow pointing 
to the right.  To resume playback of the recording, click this arrow. 

 

If the recording is playing, the playback button will switch to a pause button.  
To pause playback, press this button.  You may continue at any time by 
pressing the playback button once again. 

 

Position of Recording- 
The slider bar and position indicator are used to track the progress of the 
recording playback. 

It is also possible to use the position indicator to select the point at which you 
wish the recording to begin playing.  Using the mouse drag, position the slider 
bar to the position desired. 

 

Record Microphone Input 
 
RealFlight G4 also allows you to add your voice or other audio to the recordings.  If 
selected, the Record Microphone Input menu item activates and allows you to record 
audio input to accompany your recording. 
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Adding your voiceover to the recordings is a fantastic way to create personalized 
training lessons.  This feature presents you with the ability to create your own Virtual 
Flight Instructions that you can share with other RealFlight G4 owners around the 
world! 

 

Recordings MRU 
 
If you have previously selected a recording, you will note that it appears on a list in the 
Recordings menu title.  Lists such as this are commonly referred to as Most Recently 
Used, or MRU lists.  The MRU list is limited to the eight most recently selected 
recordings.  If you wish to view one of these recordings simply click on the name of 
the recording and it will begin. 
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Training Menu 
Practice makes perfect.  RealFlight’s Training Aids make practicing a little more 
enjoyable. 

ealFlight G4 offers a number of training aids.  These training aids are designed 
for modelers of all skill levels. 

Helicopter pilots will benefit from the Heli Hover Trainer, Heli Orientation 
Trainer and the helicopter Virtual Flight Instructions.  The Heli Hover Trainer and 
Heli Orientation Trainer offer modelers the chance to practice their stick control and 
helicopter attitude recognition.  With Virtual Flight Instructions, R/C professionals 
offer audio and visual instruction on how to perform basic, intermediate and advanced 
maneuvers. 

Airplane modelers will also benefit from the Takeoff Trainer, Landing Trainer, 
Airplane Hover Trainer and Virtual Flight Instructions. 
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Once you click on the Training menu, the following menu options appear: 

• Takeoff Trainer… 

• Landing Trainer… 

• Heli Hover Trainer… 

• Airplane Hover Trainer… 

• Heli Orientation Trainer… 

• Virtual Flight Instruction… 

 

Takeoff Trainer 
 
The Takeoff Trainer offers a great way for first time pilots to learn the basics of taking 
off an airplane.  With this trainer, you have the ability to adjust wind settings, takeoff 
direction, and overall difficult to stay on the runway. 
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To start the trainer, click Takeoff Trainer… menu item from the Training menu.  
The trainer will start automatically. 

The Takeoff Trainer feature is based on RealFlight’s Flight School flying site.  As such, 
you’ll notice that RealFlight automatically uses the Flight School airport.  You’ll see that 
the NexSTAR trainer sitting at the end of the runway, waiting for your inputs.  The 
goal is to takeoff as straight as possible down the runway, pulling back gently on the 
elevator.  As you takeoff, you’ll notice a number of arrows in the sky.  These arrows 
indicate the path that you should follow.  The arrows will appear red in color if you are 
on the correct path, blue if you are not. 
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You’ll also notice the menus have changed, which we’ll discuss here. 

Trainer Menu- 
The Trainer Menu contains the following menu items: 
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• Reset Aircraft 

• Boundary 

• Wind 

• Direction 

• Exit 

Reset Aircraft- 
If you crash or fly too far out of the boundary area, there are three ways to 
reset the aircraft: 

1. Press the Reset button on the InterLink Elite controller. This is 
probably the fastest and simplest method. 

2. Press the keyboard’s space bar. 

3. Click the Reset Aircraft menu item 
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Boundary- 
The Boundary menu item allows you the change the size of the runway path 
for which you must stay inside while taking off.  To change the size or the 
boundary, select the Boundary menu item from the Trainer menu.  A sub-
menu will appear with the following options. 

• None – Eliminates the boundary all together. 

• Small – Creates a tighter boundary which is excellent training for practicing 
precise takeoffs. 

• Medium – Creates a medium path boundary. 

• Large – Creates a large boundary. 

Once you select a boundary size, you’ll notice one blue line on either side of 
the runway.  During takeoff, you must try to stay inside these lines.  If you get 
too close, they will turn red. Correct the flight path of your airplane so that you 
are more centered on the runway. 

Wind- 
Not everyday can be an ideal day to fly.  Every pilot must learn how to takeoff 
with different wind conditions.  The Wind menu will allow you to adjust the 
direction of the wind.  When you select the Wind menu item, the following 
options will appear. 

• None – Turns the wind off to simulate a calm day. 

• Crosswind Left – This will set the wind to blow from the left of the 
aircraft. 

• Crosswind Right – This will set the wind to blow from the right of the 
aircraft. 

• Upwind (Normal) – Upwind will set the wind to blow towards the nose of 
the aircraft. 

• Downwind (Dangerous) – This will create a tail wind, making it more 
difficult to takeoff due to the decrease in airspeed. 

Direction- 
The Direction menu will allow you to change the direction in which you 
takeoff.  For an R/C pilot, you don’t have the luxury of sitting in the airplane, 
so you must learn how to control the airplane from any direction.  Selecting 
the Direction menu will show the following options. 
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• Left to Right – Take off from the left side of the runway, heading to the 
right. 

• Right to Left – Take off from the right end of the runway, heading to the 
left. 

Exit- 
If you wish to leave the Takeoff Trainer and return to the simulation, select the 
Exit menu item. 

 

Landing Trainer 
 
The old saying goes, “Take offs are easy, landings are the hard part.”  Once you master 
the Takeoff Trainer, the next step is to learn how to land, which is what the Landing 
Trainer is designed to do. 

 

To start the Landing Trainer, click the Training menu, followed by the Landing 
Trainer… menu item. 
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You’ll notice that RealFlight switched airports to Flight School, if you were not there 
already.  For this training session, you’ll be piloting Hobbico’s NexSTAR.  You’ll also 
have options, should you wish, to adjust where to start the landing, wind direction, and 
how difficult it should be to hit the runway. 

 

For landings, it’s important to understand the different legs during the approach to the 
runway. 
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When you start the Landing Trainer, you’ll notice a new menu has appeared. 

Trainer Menu- 
The Trainer Menu contains the following menu items: 

 

• Reset Aircraft 

• Boundary 

• Wind 

• Direction 

• Leg 

• Exit 

Reset Aircraft- 
If you crash or fly outside the boundary, there are three ways to reset the 
aircraft: 

1. Press the Reset button on the InterLink Elite controller.  This is 
probably the fastest and simplest method. 
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2. Press the keyboard’s space bar. 

3. Click the Reset Aircraft menu item. 

Boundary- 
The Boundary menu item allows you the change the size of the runway path in 
which you must land between.  To change the size or the boundary, select the 
Boundary menu item from the Trainer menu.  A sub-menu will appear with 
the following options. 

• None – Eliminates the boundary all together. 

• Small – Creates a tighter boundary which is excellent training for precise 
landings. 

• Medium – Creates a medium path boundary. 

• Large – Creates a large boundary. 

Once you select a boundary size, you’ll notice one blue line on either side of 
the runway.  During your landing, you must try to stay between these lines.  If 
you get too close, they will turn red.  Correct the flight path of your airplane so 
that you are more centered on the runway. 

Wind- 
Every pilot must learn how to land with different wind conditions.  In some 
respects, this can be more difficult than takeoffs, since you must learn how to 
deal with different wind conditions for each leg of the approach.  The Wind 
menu will allow you to adjust the direction of the wind.  When you select the 
Wind menu item, the following options will appear. 

• None – Turns the wind off to simulate a calm day. 

• Crosswind Left – This will set the wind to blow left across the runway. 

• Crosswind Right – This will set the wind to blow from the right across the 
runway. 

• Upwind (Normal) – Upwind will set the wind to blow towards the nose of 
the aircraft as you are on your final leg. 

• Downwind (Dangerous) – This will create a tail wind during the final leg, 
making it more difficult to land due to the decrease in airspeed. 
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Direction- 
It’s important to learn how to land from any direction.  This menu item will 
change the approach direction to learn the controls from a different aspect.  
The choices that appear when you select the Direction menu item are as 
follows. 

• Left to Right – This will set you up to land on the runway from the left 
end flying towards the right. 

• Right to Left - This will set you up to land on the runway from the right 
end flying towards the left. 

Leg- 
The Leg menu item allows you to practice each leg of the approach.  The 
options are as follows. 

• Downwind – This sets the aircraft up on the downwind side, or parallel to 
the runway.  From here, you must fly the Downwind, turn to Base, and 
then the Final for the landing. 

• Base – This sets the aircraft up for the Base leg of the approach.  You 
must complete the Base leg and then turn to the Final leg prior to landing. 

• Final – The Final leg will set you up for the landing. 

When the training lesson begins, the NexSTAR will be placed at the beginning 
of the Leg you choose.  Simply hit the Reset button on the InterLink Elite to 
begin flying. 

Exit- 
If you wish to leave the Landing Trainer and return to the simulation, select 
the Exit menu item. 

 

Heli Hover Trainer 
 
The Heli Hover Trainer offers you a great way to learn how to precisely control a 
helicopter in a hover.  With the Heli Hover Trainer, you pick which channels you wish 
to control and RealFlight will take care of the rest for you. 
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To start the trainer, click Heli Hover Trainer… menu item from the Training menu.  
The trainer will start automatically.   

You’ll notice a circle on the ground.  This circle represents the training boundary.  If 
your helicopter ventures beyond this boundary, it will break apart and the session will 
begin once again.  You’ll also note two ‘X’ marks within the boundary.  The circle 
represents the true center of the boundary, the ‘X’ represents the current location of 
your helicopter.  The goal is to control the helicopter in a stable hover, keeping it as 
close to the center of the circle as possible. 
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You’ll also notice that the menu options have changed. 

Trainer Menu- 
The Trainer Menu contains the following menu items: 
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• Reset Aircraft 

• Boundary 

• Crashes 

• Exit 
 

Reset Aircraft- 
If you crash or fly outside the circle, there are three ways to reset the aircraft: 

1. Press the Reset button on the InterLink Elite controller.  This is 
probably the fastest and simplest method. 

2. Press the keyboard’s space bar. 
3. Click the Reset Aircraft menu item. 
 

Boundary- 
The Boundary menu item allows you to change the size of the circle, or 
eliminate it altogether.  To change the size of the boundary, select the 
Boundary menu item from the Trainer menu.  A drop down menu will 
appear with the following options. 
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• None – Eliminate the boundary circle. 

• Small – Creates a small circle. 

• Medium – Creates a medium sized circle. 

• Large – Creates a large circle. 
 
Crashes- 
After a crash, RealFlight may automatically reset your helicopter for you, if so 
desired.  This option is on by default.  If you would prefer to turn this option 
off, select the Crashes menu item, then select the Automatically Reset 
Aircraft.  If a checkmark appears next to this menu item, then this feature is 
activated.  If the checkmark does not appear, it is not active. 

If Automatically Reset Aircraft is enabled, you may adjust how quickly the 
reset happens.  To adjust this delay, select the Crashes menu item followed by 
the Reset Delay menu item.  Four options will be available to you: 

• None – No delay will be set.  The aircraft will reset immediately. 

• Short – The aircraft will reset approximately one second after it crashes. 

• Medium – The aircraft will reset approximately three seconds after it 
crashes. 

• Long – The aircraft will reset approximately six seconds after it crashes. 
 
 

Exit- 
If you wish to leave the Heli Hover Trainer and return to the simulator, select 
the Exit menu item. 

 
Orientation Menu- 
The Orientation menu allows you the option to select the position and attitude of the 
heli when the session begins or the helicopter is reset. 
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A checkmark will appear next to the currently selected orientation.  The options 
available are: 

• Random Upright – The heli will start in the upright position, but it will randomly 
face either to the right, left, nose out, or nose in. 

• Random Inverted – The heli will start in the inverted position, but it will randomly 
face either to the right, left, nose out, or nose in. 

• Nose Out – The heli will start upright, facing nose out.  This option is the best 
selection for beginning heli pilots. 

• Nose In – The heli will start upright, facing nose in. 

• Left – The heli will start upright, facing to the left. 

• Right – The heli will start upright, facing to the right. 

• Nose Out Inverted – The heli will start inverted, facing nose out. 

• Nose In Inverted – The heli will start inverted, facing nose in. 

• Left Inverted – The heli will start inverted, facing to the left. 

• Right Inverted – The heli will start inverted, facing to the right. 
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Control Menu- 
The Control menu allows you to select which channel or channels to control.  All other 
channels are controlled by RealFlight, allowing you to learn just the controls you wish, 
and adding more as you become more comfortable and confident. 

 

A checkmark will appear in the menu next to the currently selected item.  Your options 
are: 

• Pitch Only – You control only the pitch of the heli, RealFlight will control the roll, 
yaw, and throttle. 

• Roll Only – You control only the roll of the heli, RealFlight will control the pitch, 
yaw, and throttle. 

• Yaw Only – You control only the yaw of the heli, RealFlight will control the roll, 
pitch, and throttle. 

• Throttle Only – You control only the throttle of the heli, RealFlight will control the 
roll, yaw, and pitch. 

• Throttle, Pitch – You control both the throttle and pitch of the heli, RealFlight will 
control the roll, and yaw. 

• Throttle, Roll – You control both the throttle and roll of the heli, RealFlight will 
control the pitch, and yaw. 
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• Throttle, Yaw – You control both the throttle and yaw of the heli, RealFlight will 
control the roll, and pitch. 

• Throttle, Pitch, Roll, Yaw – You control all channels for the heli. 
 

 

Airplane Hover Trainer 
 
The Airplane Hover Trainer offers you a great way to learn how to control an 
aerobatic airplane in a torque roll.  With the Airplane Hover Trainer, you pick which 
channels you wish to control.  RealFlight automatically controls the rest. 

 

To start the trainer, click Airplane Hover Trainer… menu item from the Training 
menu.  The trainer will start automatically.   
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You’ll notice a circle on the ground.  This circle represents the training boundary.  If 
your airplane ventures beyond this boundary, it will break apart and the session will 
begin once again.  You’ll also not two ‘X’ marks within the boundary.  One represents 
the true center of the boundary; the second is your airplane location.  The goal is to 
control the airplane in a stable hover, keeping it as close to the center of the circle as 
possible. 

You’ll also notice the menus have changed, which we’ll explain here. 

Trainer Menu- 
The Trainer Menu contains the following menu items: 
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• Reset Aircraft 

• Boundary 

• Crashes 

• Exit 
 

Reset Aircraft- 
If you crash or fly outside the circle, there are three ways to reset the aircraft: 

1. Press the Reset button on the InterLink Elite controller.  This is 
probably the fastest and simplest method. 

2. Press the keyboard’s space bar. 
3. Click the Reset Aircraft menu item. 

 

Boundary- 
The Boundary menu item allows you the change the size of the circle, or 
eliminate altogether.  To change the size or the boundary, select the Boundary 
menu item from the Trainer menu.  A drop down menu will appear with the 
following options. 
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• None – Eliminates the boundary circle. 

• Small – Creates a small circle. 

• Medium – Creates a medium-sized circle. 

• Large – Creates a large circle. 
 

Crashes- 
After a crash, RealFlight may automatically reset your aircraft for you, if so 
desired.  This option is on by default.  If you would prefer to turn this option 
off, select the Crashes menu item, then select the Automatically Reset 
Aircraft.  If a checkmark appears next to this menu item, then this feature is 
activated.  If the checkmark does not appear, it is not active. 

If Automatically Reset Aircraft is enabled, you can adjust how quickly the reset 
happens.  To adjust this delay, select the Crashes menu item followed by the 
Reset Delay menu item.  Four options will be available to you: 

• None – No delay will be set.  The aircraft will reset instantaneously. 

• Short – The aircraft will reset approximately one second after it crashes. 

• Medium – The aircraft will reset approximately three seconds after it 
crashes. 

• Long – The aircraft will reset approximately six seconds after it crashes. 
 

Exit- 
If you wish to leave the Airplane Hover Trainer and return to the simulator, 
select the Exit menu item. 

Orientation Menu- 
The Orientation menu allows you the option to select the position and attitude of the 
helicopter when the session begins or the airplane is reset. 
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A checkmark will appear next to the currently selected orientation.  The options 
available are: 

• Random – The airplane will start in a random position, with either the top, bottom, 
left side or right side facing you. 

• Top – The airplane will start with the top of the aircraft facing you. 

• Bottom – The airplane will start with the bottom of the aircraft facing you. 

• Left – The airplane will start with the left side of the aircraft facing you. 

• Right – The airplane will start with the right side of the aircraft facing you. 
 
Control Menu- 
The Control menu allows you to select which channel or channels to control.  The 
remaining channels are controlled by RealFlight, allowing you to learn just the controls 
you wish, and adding more as you become more comfortable and confident. 
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A checkmark will appear in the menu next to the currently selected item.  Your options 
are: 

• Elevator Only – Check this to control only the elevator of the aircraft.  RealFlight 
will control the throttle, ailerons, and rudder for you. 

• Aileron Only – Check this to control only the ailerons of the aircraft.  RealFlight 
will control the throttle, elevator, and rudder for you. 

• Rudder Only – Check this to control only the rudder of the aircraft.  RealFlight will 
control the throttle, ailerons, and elevator for you. 

• Throttle Only – Check this to control only the throttle of the aircraft.  RealFlight 
will control the elevator, ailerons, and rudder for you. 

• Throttle, Elevator – Check this to control the throttle and elevator of the aircraft.  
RealFlight will control the ailerons and rudder for you. 

• Throttle, Aileron – Check this to control the throttle and ailerons of the aircraft.  
RealFlight will control the elevator and rudder for you. 

• Throttle, Rudder – Check this to control the throttle and rudder of the aircraft.  
RealFlight will control the elevator and ailerons for you. 

• Throttle, Aileron, Elevator, Rudder – Check this to control all four channels.  You 
will not receive any assistance from RealFlight. 
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Heli Orientation Trainer 
 
As you become more proficient with hovering a helicopter, you can test your skills 
with the Heli Orientation Trainer.  The Heli Orientation Trainer challenges you to 
keep your helicopter in the same location as the trainer helicopter.  As you succeed in 
doing so, the trainer helicopter will move, and the level of difficulty will increase. 

 

To start the trainer, select Heli Orientation Trainer menu item from the Training 
menu. 

The Heli Orientation Trainer has a number of different levels, each with an increasing 
level of difficulty than the previous.  To pass a level you must hover your helicopter in 
close proximity to the trainer helicopter.  As you do so, the trainer helicopter will turn 
from blue to red, and the progress bar at the top of the screen will increase, indicating 
that your task is nearly complete. 
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In the upper right corner, a countdown timer is visible.  This is the amount of time you 
have to fill the progress bar and complete the task.  If you fail to do so, both the timer, 
and the progress bar will reset to zero.  You must begin once again. 

The number displayed in the upper left corner indicates the number of locations the 
trainer helicopter will stop for the current level.  It will also indicate how many of these 
locations you have completed.  For example, if it displays 1/3, you have successfully 
completed one spot out of three for the current level. 

As you advance to the next level, you may be responsible for controlling more 
channels, the allotted time might also decrease and the trainer heli will stop in more 
locations.  Additionally, you might experience any combination of these circumstances 
to increase the difficulty. 

Heli Orientation Menu- 
The Heli Orientation menu is the only menu accessible while the trainer is running.  
Two options are available in the Heli Orientation menu: 
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Select Level- 

A drop-down menu will display the levels available to you.  For example, if you 
have only progressed to Level 2, you will not be able to access Level 3 or 
higher in this menu. 
A checkmark will appear next to the level you are currently flying. 
 
Exit- 

To return to the simulator, select Exit to leave the Heli Orientation Trainer. 
 

Virtual Flight Instruction 
 
RealFlight Generation 4 includes on-screen flight training from some of R/C’s best 
pilots.  John Glezellis, Frank Noll Jr., Jason Shulman, Pete Niotis, Todd Bennett, Brian 
Bremer and Jim Bourke are your instructors taking you through a variety of skill levels 
of R/C.  There are basics for beginners as well as more advanced maneuvers for 
intermediate pilots.  G4 also includes instructions on how to perform some of today’s 
hottest 3D flight maneuvers!  G4 includes voice instruction as well as an on-screen 
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radio that shows the exact movements that the instructor is using.  VFI is the perfect 
training tool for pilots of all skill levels. 

 

To access the VFI menu item, click the Training menu followed by the Virtual 
Flight Instruction… menu item.  Alternatively, you may also access the VFI by 
pressing the ‘V’ key on the keyboard.  Determine whether you wish to participate in a 
helicopter or airplane training session.  Open the respective genre by clicking the [+] 
(plus) or double-clicking the listing.  Next, select the pilot you wish to view.  To select 
and begin your training, either double-click the respective maneuver or highlight the 
maneuver and click OK. 
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By default, G4’s radio gadget appears on-screen.  This digital transmitter is a visual 
guide to display the stick inputs, in real-time, utilized for the recordings.  For additional 
information, please refer to the Radio- section on page 245. 
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View Menu 
Adjust your vantage point, change your perspective and more. 

his menu allows you to adjust the various view-related features and functions 
for the simulation.  The View menu adjusts what you are looking at as well as 
where you are looking from. 

 

• Show 

• Camera Type 

• Camera Position 
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• Look at 

• Quick Look 

• Zoom Type 

• Zoom In 

• Zoom Out 

• Zoom Reset 

• Head Tracking 

 

Show 
 
The Show menu item is used to determine whether to show or hide scenery objects in 
the airport. 
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Selecting this item brings forth a pull-down menu with a list of items you can show 
(make visible within the simulation) or hide (remove from visibility).  To show items, 
check them in the drop-down menu.  To hide items, click on them to remove their 
respective checkmark. 

If the frame rate slows dramatically, try eliminating some of the items listed in the 
Show menu title.  This will improve the frame rate. 

To access this menu item, click on the View menu followed by the Show menu item. 

 

Camera Type 
 
The Camera Type menu item determines the Camera Type for the active viewport.  
Each viewport is independently adjustable.  Select from a Fixed Position, Cockpit or a 
Chase view. 

 

If more than one viewport is open, click on the viewport that you wish to modify.  
This becomes the active view in the simulation.  To access the Camera Type 
adjustments, click on the View menu followed by the Camera Type menu item.  
Select your preferred view from the pull-down list. 
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Alternatively, you may press the keyboard’s ‘C’ key to toggle through the available 
Camera Type options. 

Please note:  some airports do not allow Camera Type adjustments. 

Fixed Position- 
In this mode, the camera remains in a fixed, stationary position.  The position is 
determined by the Camera Position setting. 

Cockpit- 
The Cockpit selection places the camera inside the aircraft as if you were a full-scale 
pilot. 

To magnify the view or zoom in on the selected item, press the [+] (plus) key on the 
keyboard.  Each time you press the [+] (plus) key or select the Zoom In menu item, 
the zoom level increases incrementally.  Alternatively, you may select the Zoom In 
option from the View menu. 

To decrease the magnification, or zoom away from the selected item, press the [-] 
(minus) key on the keyboard.  Each time you press the [-] (minus) key or select the 
Zoom Out menu item, the zoom level decreases incrementally.  Alternatively, you may 
select the Zoom Out option from the View menu. 

Chase- 
The Chase mode positions the camera behind the aircraft.  The camera will follow the 
aircraft as it moves. 

To magnify the view or zoom in on the selected item, press the [+] (plus) key on the 
keyboard.  Each time you press the [+] (plus) key or select the Zoom In menu item, 
the zoom level increases incrementally.  Alternatively, you may select the Zoom In 
option from the View menu. 

To decrease the magnification, or zoom away from the selected item, press the [-] 
(minus) key on the keyboard.  Each time you press the [-] (minus) key or select the 
Zoom Out menu item, the zoom level decreases incrementally.  Alternatively, you may 
select the Zoom Out option from the View menu. 

 

Camera Position 
 
This menu item determines where the camera will be situated.  Depending upon the 
airport selected, there may be one or more Pilot Spawn locations to use as camera 
positions. 
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RealFlight G4 automatically picks the Pilot Spawn location that is closest to where the 
aircraft lands (or crashes, as the case may be). 

To change the setting, click on the viewport to you wish to modify.  This becomes the 
active view in the simulation.  To access the Camera Position adjustments, click on the 
View menu followed by the Camera Position menu item.  Select your preferred view 
from the drop-down list. 

You may also press the keyboard’s ‘X’ key to toggle through the available Camera 
Position options.  If the airport has two pilot spawn locations, for example, pressing 
the ‘X’ key will toggle back and forth between these two locations. 

 

Look At 
 
This menu item changes what the camera looks at.  Usually you will want the camera to 
remain focused on your aircraft. 
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Click on the viewport that you wish to modify.  This becomes the active view in the 
simulation.  To access the list of things to look at, click on the View menu followed by 
the Look At menu item.  Then select an item to look at.  For example, if you are in a 
multiplayer or MultiMode session, the other players in the session will be listed in the 
popup menu.  Select a player to look at his/her aircraft. 

 

Quick Look 
 
This feature allows you to quickly glance at an object.  When you activate this option, 
the camera briefly looks at the selected item and then returns to the previous vantage 
point for the active viewport. 
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Click on the viewport that you wish to modify.  This becomes the active view in the 
simulation.  To access the Quick Look menu item, click on the View menu followed 
by the Quick Look menu item.   

Using the InterLink Elite controller, you can also active the Quick 
Look options with the QuickSelect buttons.  By pressing up on the 
Data Lever, RealFlight will briefly change the camera to look at the 
Wind Sock.  Pressing down will briefly bring the Ground into view. 

 

Alternatively, after you have activated the correct viewport, you can press a key on your 
keyboard to activate the Quick Look feature.  The up arrow will look at the windsock, 
and the down arrow will look at the ground. 

 

Zoom Type 
 
The Zoom Type menu item allows you to change the type of zoom used in the 
simulation. 
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Click on the viewport that you wish to modify.  This becomes the active view in the 
simulation.  To access the Zoom Type menu item, click on the View menu followed 
by the Zoom Type menu item.  Select the Zoom Type option that accomplishes your 
goal.  You may choose between Manual, Autozoom, and Keep Ground in View. 

Alternatively, after you have activated the correct viewport, press the keyboard’s ‘Z’ key.  
Each time you press the ‘Z’ key you will toggle to the next Zoom Type. 

Autozoom- 
This zoom type adjusts the zoom range based on the distance of the aircraft from the 
pilot.  The camera automatically zooms in as the aircraft gets further from the pilot and 
then automatically zooms out as the aircraft gets closer to the pilot. 

Keep Ground in View- 
This zoom type adjusts the camera so that the aircraft and the ground are always in 
view.  This is the only zoom type that disallows zooming in and out. 

Manual- 
This enables the standard view with zoom capabilities.  See the Zoom In and Zoom Out 
sections below for more information. 
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Zoom In 
 
Once you have selected the type of zoom that you desire, RealFlight allows you to 
customize it further by zooming in. 

 

Click on the viewport that you wish to modify.  This becomes the active view in the 
simulation.  To access the Zoom In menu item, click on the View menu followed by 
the Zoom In menu item. 

Alternatively, after you have activated the correct viewport, press the [+] (plus) key on 
your keyboard.  Each time you press the [+] (plus) key you will zoom in incrementally. 

 

Zoom Out 
 
Once you have selected the type of zoom that you want you can customize it further 
by zooming out.  Zooming Out decreases the magnification. 
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Click on the viewport that you wish to modify.  This becomes the active view in the 
simulation.  To access the Zoom Out menu item, click on the View menu followed by 
the Zoom Out menu item. 

After you have activated the correct viewport, you may also press the [-] (minus) key 
on your keyboard.  Each time you press the [-] (minus) key you will zoom out 
incrementally. 

 

Zoom Reset 
 
This selection resets the zoom magnification level to its default value.  This is useful if 
you are zoomed way in or way out and want to return quickly to the default level of 
magnification. 
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Click on the viewport that you wish to modify.  This becomes the active view in the 
simulation.  To access the Zoom Reset menu item, click on the View menu followed 
by the Zoom Reset menu item. 

Once you have activated the correct viewport, you may also press the Backspace key 
on your keyboard to reset the zoom level. 

 

Head Tracking 
 
RealFlight G4 is compatible with TrackIR from NaturalPoint.  With a TrackIR plugged 
into your computer, you can control the camera with the movement of your head as if 
you are at the field looking around. 
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For example, if you are flying at a high altitude and wish to line up with the runway, at 
a flying field you would look down briefly.  With the TrackIR, you would do the same 
at your computer.  With a small movement of your head, you can look down at the 
runway and back up to your aircraft. 

For more information about TrackIR, and where to purchase one, visit NaturalPoint’s 
website at: 

http://www.naturalpoint.com/trackir/
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Window Menu 
Tools to add more excitement to your RealFlight enjoyment. 

he Window menu allows you to manage the existing windows or viewports, to 
create new ones, and to select from recently used Windows.  The Window 
menu also gives you access to a variety of on-screen gadgets that offer real-
time information about your current flight. 

 

The Window menu offers the following options: 

• Show Title Bar 
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• Gadgets 

• Arrange 

• Close All 

• Window list 

 

Show Title Bar 
 
This menu item determines whether or not the G4 title bar is displayed on the screen.  
By default, the title bar is enabled. 

 

To access this menu item, click on the Window menu followed by the Show Title 
Bar.  This will remove the RealFlight Generation 4 title bar from the screen.  Please 
note:  removing the title bar also eliminates the ability to minimize or maximize the 
screen. 
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Gadgets 
 
A Gadget is an on-screen display that provides you with information pertaining to a 
certain item in your simulation.  To access the Gadgets menu item, click the Window 
menu followed by the Gadgets menu item.  This will open the list of gadgets for the 
simulation. 

 

Selecting this menu item will bring up the Gadgets list as follows: 

• NavGuides 

• Radio 

• Binocular 

• Viewport 

• Variometer 

• Console 
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• Chat 

• Edit NavGuides 

• Radio Mode (gadget only) 

 
NavGuides- 
A NavGuide is an on-screen display that allows you to view some basic information 
pertaining to your aircraft.  If you wish to alter the contents of the NavGuide, please 
refer to the Edit NavGuides… section later in this chapter. 

 

To access the NavGuides, click the Window menu title, followed by the Gadgets 
menu item.  Next, click the NavGuides menu item.  You may also bring up the 
NavGuides by pressing the keyboard’s ‘1’ key. 

You may also load the NavGuides using the InterLink Elite with 
the QuickSelect buttons.  Press the Menu/Select button.  Then 
press down twice on the Data Lever until the NavGuides tab is 
highlighted.  It looks like an aircraft gauge. Press the Menu/Select 
button again to activate the NavGuides.  Repeat these steps to 
remove the NavGuides from the screen. 

When the NavGuides are active, an overlay screen will appear on your display.  This 
screen displays the NavGuides information to you. 

If you do not wish to view this information, double-click on the title bar of the display 
box.  This hides the information.  To view it once again, simply double-click the title 
bar. 

To resize the overlay, position the cursor over the arrow indication found in the lower 
right corner of the frame.  Click and hold on the arrow.  Using the mouse, drag the 
frame according to your wishes.  If you drag it downward, the vertical size of the 
viewport will increase.  Dragging the frame to the right or left increases or decreases 
the width of the viewport respectively. 

Clicking on the ‘X’ in the title tab of the frame will remove it from the screen, entirely. 

 



 

 245

Items included by default in the NavGuides are the following: 

Altitude (ASL)- 
This option displays the altitude for the respective aircraft above sea level.  
Even though the aircraft may be taxiing on the runway, the altitude may reflect 
hundreds or thousands of feet, if applicable. 

Heading- 
This option displays the heading of the aircraft.  The heading is displayed in 
degrees, as they would appear on a compass.  “0” degrees is North, “90” 
degrees is East, “180” degrees is South and “270” degrees is West. 

Airspeed- 
This option displays the airspeed for the aircraft. 

RPM- 
This option indicates the current revolutions per minute, or RPM’s, for the 
engine. 

Graphics Frames/Sec- 
This is an abbreviated version of Frames per Second, or FPS.  While the data 
displayed is not relevant to your aircraft, it is used to provide you with 
feedback on how your computer is performing at any given time.  The higher 
the frames per second, the smoother the simulation will appear. 

Wind- 
This option displays the current wind speed at the flying site. 

Radio- 
The on-screen radio display is useful for many facets of flight.  For example, when 
used in conjunction with Virtual Flight Instruction, this allows you to see real-time 
control input from the professionals.  Observing the link between controller 
movements and aircraft performance will advance your knowledge and understanding 
of a maneuver. 
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To access the Radio, click the Window menu title, followed by the Gadgets menu 
item.  Next, click the Radio menu item. 

You may also bring up the Radio by pressing the keyboard’s ‘2’ key. 

You may also load the Radio using the InterLink Elite with the 
QuickSelect buttons.  Press the Menu/Select button.  Then press 
down three times on the Data Lever until the Radio tab is 
highlighted. Press the Menu/Select button again to activate the 
on-screen Radio.  Repeat these steps to remove the Radio from the 
screen. 

If you click the on-screen radio, the entire viewport is displayed, including the title bar.   

To resize the viewport, position the cursor over the lower right corner of the 
viewport’s frame.  Using the mouse, drag the frame according to your wishes.  If you 
drag it downward, the vertical size of the viewport will increase.  Dragging the frame to 
the right or left increases or decreases the width of the viewport respectively. 

Clicking on the ‘X’ in the title tab of the frame removes it from the screen. 

Binocular- 
The Binocular option will show a perfectly zoomed aircraft, as if you were looking 
through a pair of binoculars.  The background of the viewport box becomes 
transparent.  This provides a visual indicator alerting you that you are using “binocular 
vision.” 
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The Binocular option is a great way to see the control surfaces on an aircraft that is too 
far away to see in the Main View.  Although not realistic, it does help to see the control 
input. 

To access the Binocular menu item, click the Window menu title, followed by the 
Gadgets menu item.  Next, click Binocular. 

You may also bring up the Binocular option by pressing the keyboard’s ‘3’ key. 

You may also load the Binocular viewport using the InterLink Elite 
with the QuickSelect buttons.  Press the Menu/Select button.  
Then press down four times on the Data Lever until the Binocular 
tab is highlighted. Press the Menu/Select button again to activate 
the Binocular viewport.  Repeat these steps to remove the Binocular 
viewport from the screen. 

Clicking the Binocular viewport will display the title bar and frame.  To resize the 
viewport, position the cursor over the arrow indication found in the lower right corner 
of the viewport’s frame.  Click and hold on the arrow.  Using the mouse, drag the 
frame according to your wishes.  If you drag it downward, the vertical size of the 
viewport will increase.  Dragging the frame to the right or left increases or decreases 
the width of the viewport, as appropriate. 
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Clicking on the ‘X’ in the title tab of the frame removes the frame from the screen. 

Viewport- 
The Viewport menu item allows you to open up a smaller window to you can adjust 
independently from the main simulator screen.  This works much like a picture-in-
picture features found on many TVs.   

 

Once you create a new viewport, you can resize or reposition it by dragging with your 
mouse.  You can also fully adjust all the viewport’s properties (zoom level, vantage 
point options, etc.), independent of any properties of the main window. 

To access the Viewport menu item, click on the Window menu followed by the 
Gadgets menu item.  Then select Viewport.  

You may also bring up the Viewport by pressing the keyboard’s ‘4’ key. 

You may also load the Viewport using the InterLink Elite with the 
QuickSelect buttons.  Press the Menu/Select button.  Then press 
down five times on the Data Lever until the Viewport tab, 
pictured with a video camera, is highlighted. Press the 
Menu/Select button again to activate the Viewport.  Repeat these 
steps to remove the Viewport from the screen. 
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To change the vantage point options and features, use the commands found in the 
View menu.  Ensure that the viewport you wish to modify is the active viewport, or the 
modifications will not take effect. 

Clicking on the ‘X’ in the viewport’s title tab removes it from the screen. 

Variometer- 
A variometer is an instrument designed to indicate the rate of climb or descent of an 
aircraft.  The variometer is useful to pilots flying powered aircraft so they can ascertain 
that level flight is maintained.  This is useful during turning maneuvers.  Glider pilots 
typically make the most use of a variometer, to help determine the areas of rising or 
sinking air currents. 

 

To access the Variometer, click the Window menu title, followed by the Gadgets 
menu item.  Next, click the Variometer menu item. 

You may also bring up the Variometer by pressing the keyboard’s ‘5’ key. 

You may also load the Variometer using the InterLink Elite with the 
QuickSelect buttons.  Press the Menu/Select button.  Then press 
down six times on the Data Lever until the Variometer tab, 
pictured with a sailplane, is highlighted. Press the Menu/Select 
button again to activate the Viewport.  Repeat these steps to remove 
the Variometer from the screen. 

The variometer available in RealFlight also offers an audio indicator, much like the real 
instrument.  As the rate of climb increases, the pitch in the audio tone will increase, as 
well.  The opposite holds true, as the descent of the aircraft increases, the pitch in the 
audio tone decreases accordingly. 
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If you wish to turn off the audio ques, click the button with the speaker symbol in the 
lower right corner on the variometer.  To turn the audio back on, click the button once 
again. 

The variometer in RealFlight G4 is split into two parts.  The left side of the variometer 
includes a status meter which indicates whether the aircraft is ascending, descending or 
maintaining level flight.  If the bar is in the green, the aircraft is rising.  If it is in the red, 
then the aircraft is descending.  If it remains stationary in the middle, the aircraft is 
maintaining its altitude.  The farther the bar moves from the center, the faster the 
change in altitude. On the right, there are three readouts that offer the following. 

• Rate – This indicates the rate of change in altitude. 

• ASL – This shows the altitude above sea level. 

• AGL – This indicates the altitude above ground level. 

Clicking the Variometer viewport will display the title bar and frame.  Clicking on the 
‘X’ in the title tab of the frame removes the frame from the screen. 

Console- 
The Console, and its related commands, will generally be used only by RealFlight’s 
power users or those with advanced knowledge of gaming systems, etc.  As such, we 
will simply scratch the surface of the Console in this manual.  For additional 
information and assistance, we encourage users to visit the RealFlight forums at:: 

http://www.knifeedge.com/forums/ 

To access the Console, press the ‘~’ key.  A complete list of commands is available by 
typing ‘help’ in the command line and pressing Enter. 

Chat- 
Chatting offers the ability to communicate with other RealFlight players during a 
multiplayer session.  Select this menu item to bring up the chat field at the bottom of 
the simulator screen.  To send a message, type your message in the field and press 
Enter on the keyboard. 

Alternatively, press the Enter key first to bring up the Chat field at the bottom of the 
screen.  Next, using the keyboard, type the message you wish to send.  Press the Enter 
key again on the keyboard to send the message. 

Please note:  all messages are viewable by all participants.  RealFlight G4 does not offer 
private chat. 

Any messages received from other participants will appear at the bottom of the screen. 
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Edit NavGuides…- 
This menu item allows you to modify the data displayed in the NavGuides box. 

To access the Edit NavGuides feature, click the View menu title, followed by the 
Gadgets menu item.  Next, click the Edit NavGuides… menu item. 

 

Modifying the NavGuides- 
To add any of the options from the left column to the NavGuides display, 
click in the box next to the respective item. 

The pane below the list of the Edit NavGuides dialog box contains a 
description of the respective item. 

The Reset To Basic button returns all NavGuides to their default values and 
options.  If you wish to choose all items in the NavGuides list, click the Select 
All button.  All NavGuides items will then be shown in the on-screen display.  
To remove all items from the list, click the Select None button. 
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The NavGuides available are listed in the following table: 

Option Description 

Aircraft: Altitude (AGL) Check this item to display the current altitude of the 
aircraft above ground level. 

Aircraft: Altitude (ASL) Check this item to display the current altitude of the 
aircraft above sea level. 

Aircraft: Altitude (ATL) Check this item to display the current altitude of the 
aircraft compared to the terrain below.  This option does 
not account for water. 

Aircraft: Altitude (AWL) Check this item to display the current altitude of the 
aircraft above the body of water at the airport. 

Aircraft: G Force Check this item to display the gravitational load of the 
aircraft is experiencing as felt by the pilot. 

Aircraft: G Force Total Check this item to display the gravitational load of the 
aircraft is experiencing in any direction. 

Aircraft: Ground Speed Check this item to display the current ground speed of 
the aircraft. 

Aircraft: Heading of Aircraft Check this item to display the current heading of the 
aircraft.  This heading is displayed in degrees, as they 
would appear on a compass.  “0” degrees is North, “90” 
degrees is East, “180” degrees is South and “270” 
degrees is West. 

Aircraft: X Position of Aircraft Check this item to display the current X position of the 
aircraft. 

Aircraft: Y Position of Aircraft Check this item to display the current Y position of the 
aircraft. 

Airspeed: Speed of Aircraft Check this item to display the current airspeed of the 
aircraft. 

Engine: Battery Remaining Check this item to display the remaining capacity in the 
battery pack. 

Engine: Current Draw Check this item to display the amount of current that the 
motor is draining from the battery pack. 

Engine: Fuel Remaining Check this item to display the amount of fuel remaining. 

Engine: Motor Efficiency Check this item to display the efficiency of the electric 
motor. 

Engine: Power In Check this item to display the amount of power being 
transferred to the electric motor. 

Engine: Power Out Check this item to display the amount of power being 
generated by the engine. 

Engine: RPM Check this item to display the RPM’s of the engine.  
Note: this measurement does not take into account any 
gear reduction which might be utilized. 

Engine: Voltage Check this item to determine the voltage across the 
electric motor. 

Helicopter: Main Rotor RPM Check this item to display the current main rotor RPM of 
the helicopter. 
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Helicopter: Tail Rotor RPM Check this item to display the tail rotor RPM of the 
helicopter. 

Pilot: Distance to Aircraft Check this item to display the current distance from the 
pilot to the aircraft. 

Pilot: Field Of View Check this item to display the field of view angle for the 
main window. 

Pilot: Height (AGL) Check this item to display the height of the pilot above 
the surface below, water or ground. 

Pilot: Height (ASL) Check this item to display the height of the pilot above 
sea level. 

Pilot: Height (ATL) Check this item to display the height of the pilot above 
the terrain, not including any body of water. 

Pilot: Height (AWL) Check this item to display the height of the pilot above 
the body of water at the airport. 

Pilot: Look Direction Check this item to display the compass direction in 
which the pilot is looking. 

Pilot: Zoom Magnification Check this item to display the amount of zoom being 
utilized; 1 is equivalent to normal eyesight. 

System: Graphics Frame Rate Check this item to display the number of times the 
screen updates per second. 

System: Physics Frame Rate Check this item to display the number of times the 
physics system updates per second. 

Wind Direction Check this item to display the direction that the wind is 
blowing. 

Wind Speed Check this item to display the velocity of the wind at the 
current time. 

Wind Updraft Check this item to display the velocity of the wind in the 
upward direction. 

 

Color- 
This setting adjusts the Color for the selected item.  To select an alternate 
Color, click on the color swatch.  This will open the color palette dialog and 
you may choose an alternate color for the item. 

Show only when value is between- 
Click on the box to activate the option for Show only when value is 
between.  If the aircraft parameter falls within the specified range, the selected 
item will appear in the NavGuides.  If the parameter is not within the specified 
range, the item will not be shown. 

To adjust the range, click on the respective value box and input the value via 
your keyboard. 

Change color when value is between- 
Click on the box to activate the option for Change color when value is 
between.  If the aircraft parameter falls within the desired range, the selected 
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item will appear in the NavGuides in the alternate color.  If the parameter is 
outside of the specified range, the item will be shown in the primary color. 

To adjust the range, click on the respective value box and input the value via 
your keyboard. 

Radio Mode (gadget only)- 
This option allows you to change the Mode in which the on-screen radio is displayed.  
For example, if you prefer to fly with the throttle and rudder on the left stick, and 
ailerons and elevator on the right stick, then you fly Mode 2.  Some modelers prefer 
Mode 1.  In this mode, the left stick controls the rudder and elevator; the right stick 
controls the throttle and ailerons. 

 

Whichever mode you fly, you will want the on-screen radio to match.  Select Radio 
Mode (gadget only) to show the list of available radio modes.  Click the mode that is 
appropriate for you. 
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Arrange 
 
This menu item allows you to organize the on-screen viewports.  This is especially 
helpful when there are multiple windows open that overlap one another. 

 

Click on the Window menu followed by the Arrange menu item to activate this 
option. 

 

 

Close All 
 
This menu item closes all open Windows with the exception of the main Window.  It 
offers the user an easy method to clean up the screen without having to close each 
window separately. 
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To access the Close All menu item, click on the Window menu followed by the Close 
All menu item. 

 

Viewport List 
 
As you add more viewports to the screen, note that they appear on a list in the 
Window menu title.  If you wish to change the active view to one of these viewports, 
simply click on the viewport name in the list. 
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To determine the active window, simply search for the yellow outline that surrounds 
the active window.  In the example above, the active window is Binocular. 

To change the active window, click on, or in, the window that you wish to become 
active.
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Help Menu 
When all else fails, ask for help. 

his menu provides you with miscellaneous assistance and guidance with a 
variety of simulator-related issues. 

To access the Help files, click on the Help menu title. 

 

The menu items available under the Help menu are: 

• Contents… 

Chapter

14
T 



 

 260

• Keyboard Commands… 

• About… 

• License… 

• Websites 

 

Contents 
 
This menu item accesses RealFlight G4’s manual which you are reading now. 

 

To access the Contents… files, click on the Help menu title. 
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Keyboard Commands 
 
RealFlight allows you to access menu and other commands from your computer’s 
keyboard.  A key that directly invokes a command is called a “quick key” or “hot key”. 

For example, pressing the [+] (plus) key on the keyboard’s number pad incrementally 
zooms your view towards the aircraft.  This is exactly the same result that arises if you 
select Zoom In from G4’s View menu item.  Consequently, we say that the [+] (plus) is 
a hot key for the Zoom In command. 

 

To access the Keyboard Commands, click the Help menu title, followed by the 
Keyboard Commands menu item. 

Alternatively, you may also bring up the Keyboard Commands by pressing the 
keyboard’s ‘H’ key. 

The following overlay will appear: 
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The Keyboard Commands screen contains all of the information pertaining to the hot 
keys.  To view the entire list, drag the scroll bar on the right side of the Keyboard 
Commands screen down.  Alternatively, this list is also contained in the inside rear 
cover of the Installation Guide which accompanied this software. 

If you do not wish to view this information, double-click on the title bar of the display 
box.  This will hide the information.  To view it once again, simply double-click the 
title bar. 

Clicking on the ‘X’ in the title tab of the frame will remove it from the screen. 

 

About 
 
The About… menu item contains miscellaneous information pertaining to your 
software.  The About… menu contains your RealFlight serial number, InterLink Elite 
serial number and the version number of the software that you are currently operating. 
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Also seen in the About screen are the credits and names of the people that have 
worked together to bring you the world’s most realistic R/C simulator, RealFlight 
Generation 4. 

Clicking on the ‘X’ in the title tab of the frame or clicking anywhere on the main 
simulator screen will remove the About window. 

 

License 
 
This menu item contains the End Users License Agreement (EULA) for the RealFlight 
R/C Flight Simulator.  Please read it carefully. 
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Clicking on the ‘X’ in the title tab of the frame will remove it from the screen. 

 

Websites 
 
This menu item contains links to the RealFlight related websites.  The options include: 
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Great Planes- 
Publishers of RealFlight G4.  Visit this site for information pertaining to the many 
other Great Planes products available. 

Knife Edge Software- 
Developers of RealFlight G4.  Visit the Knife Edge forums to share experiences and 
technical support with other RealFlight owners.  The Knife Edge forums also play host 
to a wide variety of free, downloadable aircraft, trim schemes, flying sites and more. 

RealFlight- 
Visit the RealFlight website for more information about the RealFlight family of 
products, search the knowledge base for technical support, or for information on how 
to contact our support staff if you have questions. 
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Basics of Flying 
Understanding the fundamentals of  radio control flying. 

efore taking control of a transmitter, it helps to understand the basics of flight, 
and the functionality of the gimbals, sticks and switches to properly control 
the aircraft.  This chapter reviews the basics of flying an airplane or a 
helicopter to help get you started down the right path. 

 

Airplane Basics 
 
Before you fly the plane, make sure all switches are in their off or low rates, positions.  
The switches may be assigned to different items depending on how you have 
configured your controller and which aircraft you are flying.  If you are using your own 
transmitter to control RealFlight, please consult your transmitter owner’s manual for 
more information. 

The InterLink Elite features digital trim tabs which are more precise and offer trim 
memory within the simulation.  Trim tabs are the small slider controls on the controller 
(two per controller stick).  They “trim” the aircraft so that it flies straight and level.  For 
example, if an airplane has a tendency to veer slightly downward, you may need to add 
a slight “up” nudge to the elevator.  You can do this by sliding the elevator trim, a click 
or two at a time, towards the bottom of the controller. 

Crashing- 
Takeoffs are optional, but landings are mandatory.  For any type of aircraft or flying, 
successfully landing an aircraft is a crucial skill to master. 

The key to a perfect landing is undivided concentration.  Pay close attention to the 
altitude, orientation, and speed of the aircraft as it approaches the runway.  Should you 
happen to crash, use each crash as a learning experience to perfect your approach and 
the landing. 
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RealFlight has several tools to help you stay on top of things during approach and 
landing.  See the “Landings” section below for some ideas. 

Out at the field a crash might result in one or more of the following: 

• Bruise your ego 

• End flying for the day 

• Cost you money 

• Cost you time to rebuild 

• Cause injury to yourself or a bystander 

• Even win you a nice “best crash trophy!” 
 
Of course, when you crash on the simulator, there is really no harm done.  None, that 
is, except the bad habits you may acquire.  We suggest that you take the crashes 
seriously and learn from each one.  By doing so, you will be a better pilot out at the 
field. 

Airplane Flight- 
RealFlight G4 accurately simulates how R/C aircraft really fly.  This allows you to 
practice R/C flight without worrying about expensive crashes.  Additionally, RealFlight 
G4 is ideal for practicing new maneuvers and experimenting with various parameter 
adjustments. 

It is important to remember, however, that a simulator will only help you learn to fly if 
you let it.  Otherwise, it is just a game.  Learning to fly R/C aircraft requires a 
commitment.  One does not just grab the sticks and start dazzling the crowds.  A 
methodical, patient approach will help you get the most out of this simulator. 

This section is not designed to teach you how to fly.  However, it will help you enhance 
your experience with the simulator and obtain the most from your experiences. 

Takeoffs- 
When you are taking off, start with the throttle in low position and slowly 
increase throttle by pushing the throttle stick away from you towards the top 
of the transmitter until you are at about half speed.  Stay in the middle of the 
runway (you can steer the plane using the rudder).  When you have built up 
enough speed, gradually pull back on the elevator stick to climb off the runway.  
If the plane is tracking well, apply the rest of the power more quickly, climb 
out, and gain altitude. 

Be careful not to veer off the runway.  In a real plane, chances are that you 
would crash (or get stopped on the grass).  Usually this means bent landing 
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gear and a broken prop.  If your plane has retracts, they could even be torn out 
of the wing. 

For the best practice, it’s recommended that you utilized the Takeoff Trainer 
available with RealFlight G4.  For more information, see the Takeoff Trainer 
section on page 200. 

Landings- 
It is very important to land on the runway, rather than veering off, or touching 
down before you reach the runway.  Either of the latter usually produces a 
moderately expensive crash.  If you “cartwheel” (wing tip hits the ground first), 
the wing can break, resulting in lengthy down time while you repair your 
airplane. 

Start by aligning your plane parallel with the runway.  Fly the approach 
normally, using your throttle to control the rate of descent.  Try to land at the 
slowest speed possible.  If your plane has flaps, use them to kill speed (but be 
careful; with flaps down your plane will try to pitch up and climb).  If your 
plane has retractable landing gear, lower them.  As you touch down, remember 
to keep your nose up! 

RealFlight has several tools to help you practice landings.  

• Before you try to land yourself, you may want to get a lesson from a pro.  
To do so, click the Training menu followed by the Virtual Flight 
Instruction… menu item.  Choose Jason Shulman as the instructor.  
From the list of options, select the Landing maneuver. 

• Gain experience through the Landing Trainer.  It offers guidance and 
helps set you up for the perfect landing.  See the Landing Trainer on page 
205 for more information. 

• During your approach, use the NavGuides to keep track of your speed, 
altitude, and distance above ground. 

 

Aerobatics- 
When you practice aerobatics, the three important steps are: 

• Start the plane straight and level, in a controlled situation 

• Perform the maneuver 

• Return to a straight, controlled situation 
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Anyone can give it full throttle, jam the sticks in all directions and watch the 
plane tumble and roll.  However, this is not what you will do out in the field.  
Do this and you will not have control of the airplane! 

The key to properly performing the maneuver is in the setup.  Doing so will 
allow you to cleanly finish and your experience will be more rewarding as well 
as more realistic. 

Concentrate on making the maneuvers “clean and crisp.”  If you are doing a 
roll, try to keep the plane on a straight line as you roll.  If you are doing a loop, 
try to make a perfectly round circle. 

If you want to practice aerobatics using RealFlight G4, try the Virtual Flight 
Instruction feature (accessible via the Training menu).  The Virtual Flight 
Instruction feature provides a series of personal lessons taught by pros. 

Throttle Management- 
Avoid the temptation of giving the plane full throttle and keeping it there for 
hours at a time.  This teaches you bad habits and makes even a good flier look 
like a rookie out at the field. 

Many of the maneuvers require proper throttle management in order to make 
a maneuver look good.  Loops, stalls, torque rolls, touch-and-goes are just a 
few examples.  Try doing various maneuvers at differing speeds.  Try 
performing a slow roll at medium throttle and keeping a perfectly straight line.  
This difficult maneuver will earn you more praise at the field than doing a full 
speed, full stick roll. 

Rudder Management- 
Most airplanes can (more or less) be effectively flown with just the elevator and 
ailerons.  Good pilots will tell you that the proper use of the rudder is just as 
important, however.  Many aerobatic maneuvers require excellent rudder usage. 

Rudder control is especially important when landing in a crosswind.  Pilots that 
cannot use the rudder usually land in the tall grass (embarrassing!).  Pilots that 
do use the rudder can land on the numbers almost every time. 

 

Helicopter Basics 
 
A model helicopter is a very complicated machine, which operates on the same 
aerodynamic principles as its full-scale counterpart.  These principles are quite 
complicated to explain and understand.  However, it is not necessary to understand all 
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the underlying aerodynamics in order to successfully fly a model helicopter (or a 
computer simulation). 

The following will help you to better understand the basics of helicopter flight, and the 
relationship between control stick movements and the actions of the machine. Refer to 
these instructions often as you become more proficient. 

Please note:  the inputs below are shown using a Mode 2 transmitter. 

Collective (Left Stick – Vertical Movement)- 
The spinning main rotor blades, which act like rotating wings, lift the helicopter into 
the air.  Changing the pitch (angle of attack) and speed of the blades, using the 
“collective” and throttle causes the helicopter to rise and descend vertically.  Adjusting 
“collective” increases and decreases the blade pitch.  The “throttle” control increases 
and decreases engine RPM.  On a model helicopter, the collective and throttle controls 
are mixed electronically, and controlled by the throttle stick on the transmitter or 
controller. 
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Rudder (Left Stick – Horizontal Movement)- 
To turn the nose of the helicopter left or right, change the tail rotor pitch (by using the 
“rudder” control).  Changes in collective stick movement will require changes in the 
amount of rudder input to maintain the desired heading. 
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Cyclic Stick (Right Stick)- 
The cyclic stick replaces the “aileron” and “elevator” controls found on a fixed-wing 
aircraft.  “Cyclic” is the term given to the control of the main rotor that allows the 
helicopter to fly forward, backward, left and right.  Forward cyclic stick movement 
causes the helicopter to pitch forward, left cyclic causes the helicopter to tilt sideways 
to the left, on so on.  You move the helicopter forward or sideways using a coordinated 
movement of both the cyclic and collective control sticks.  Moving the cyclic stick to 
the right, while simultaneously increasing collective, will cause the helicopter to move 
sideways to the right.  “Rudder” control is used to maintain the heading. 

 



 

 274

 

 



 

 275

 
 

Idle-Up- 
A switch on the controller actuates a special function, known as “idle-up.”   Idle-up 
offers an alternate throttle and pitch curve, different from the curves used for hovering.  
Idle-up is usually used for aerobatics, when the pilot wants engine power added when 
pitch is subtracted.  For example, inverted hovering requires positive throttle and 
negative pitch.  As such, pulling the collective stick back provides positive throttle 
AND increased pitch simultaneously. 

Throttle Hold- 
Another special function is known as the “throttle hold”.  When activated, this switch 
sets your throttle to idle but allows the collective to function normally.  This allows you 
to practice autorotations without shutting the engine off. 

Gyro- 
Any sudden change to the torque of the main rotor, such as a quick change in RPM or 
a wind gust, can cause the helicopter to turn unintentionally to an unwanted direction. 
An electronic device known as a gyroscope (gyro) is used to “monitor” and correct for 
this by giving commands to the rudder control to help stabilize the machine. 

Gyros come in a variety of types, each with different features.  A normal gyro will not 
return the helicopter to its former heading; it will simply dampen the unwanted sudden 
movement.  We recommend you start by using the heading hold gyro instead; it will 
maintain course and keep the nose of the helicopter pointed in the desired direction 
regardless of outside forces. 
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Helicopter Flight 
 
Hovering- 
The machine hovers by adjusting the collective/throttle control to maintain altitude, 
the rudder to maintain heading, and minute adjustments to the cyclic controls to 
maintain location.  Hovering is the most important aspect of helicopter flight to master, 
since every other movement of the machine begins and ends with a hover. 

Forward Flight- 
The helicopter moves forward by changing cyclic (moving the cyclic control forward).  
This causes the rotor head, and thus the helicopter to tilt forward, resulting in a 
forward thrust. As the cyclic increases, the collective must also be increased to maintain 
the desired flight path.  As forward speed increases, the collective can be reduced 
slightly. 

Backward Flight- 
Backward flight is accomplished by moving the cyclic control aft, which causes the 
rotor head, and thus the helicopter to tilt backward.  As the cyclic is moved aft, the 
collective must also be increased to maintain desired flight path.  As backward speed 
increases, the collective can be reduced slightly. 

Sideways Flight- 
Moving the cyclic control left will cause the rotor head, and thus the helicopter to tilt 
left.  Add collective and left rudder to cause the helicopter to “slide” sideways to the 
left.  As speed increases, it will require progressively more rudder to maintain heading. 

To move right, simply follow the same procedure, but reverse the cyclic and rudder 
movements (move cyclic right, apply right rudder). 

Turning- 
From forward flight- 
Moving the cyclic control left, while applying a small amount of aft cyclic and 
feeding in left “rudder”, will cause the helicopter to make a coordinated turn to 
the left.  Right movement of the cyclic and rudder sticks will cause the heli to 
turn to the right. 

From a hover- 
Use the rudder to rotate the nose of the helicopter in the direction you want. 

Learning to fly a model helicopter is more difficult and challenging than any 
other genre of radio control modeling, but is also the most rewarding as you 
master the techniques required for sustained hover and forward flight.  
Computer simulation of model helicopter flight is an excellent tool for learning 
the basics and dramatically reducing the learning curve when you move on to 
the actual model itself. 
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RealFlight G4 Launcher 
The RealFlight G4 Launcher is the gateway to simulator fun! 

his item allows you to run the simulation, register and update the software, and 
much, much more. 

To run RealFlight or to access the additional options, click the RealFlight G4 
Launcher located on your desktop. 
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Run RealFlight 
 
To start running RealFlight, press the RealFlight G4 Launcher located on your 
desktop.  Next, click the Run RealFlight button.  The simulation will begin loading 
the terrain, airport objects, textures, etc.  Your simulation experience will begin as soon 
as the loading process completes. 

 

Additional Options 
 
Click on the Additional Options button to access a variety of useful information 
pertaining to RealFlight G4. 



 

 279

 

Restore Defaults- 
Use this button to restore RealFlight G4’s default settings.  Doing so will NOT remove 
custom aircraft, flying sites, etc.  Rather, it is designed to simply restore the factory 
default values and settings for the simulation. 

Registration/Updates- 
Use this button to register and update the software. 
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Online Registration- 
This button allows you to register your copy of RealFlight G4.  The 
registration information entitles you to complimentary technical support and 
free online updates. 

Please enter in all of the required information to complete the registration.  If 
you forget your password, contact Great Planes Support.  To do so, email 
them at rfsupport@greatplanes.com or telephone them at 217-398-8970 
(option #1).  They will confirm your identity, and reset your password. 

Hardware Information- 
RealFlight G4 offers the option of automatically sending us 
information pertaining to your system hardware and settings when you 
register.  If you leave the Send Hardware Information box checked 
when you register, RealFlight G4 will send us this information. 
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This hardware information will assist us in diagnosing any problems 
you may encounter later, should you need to contact Technical 
Support Consequently, we suggest that you leave this box checked 
when registering. 

This feature is optional.  If you uncheck the box, RealFlight G4 will 
not send us any information about your system.  Alternatively, you can 
view exactly what information RealFlight will send us before you 
decide.  To view the information, click the Technical Support button.  
When the Technical Support page appears, click Assemble System 
Information. 

Update to Latest Version- 
After registering (you only need to register once), you may update to the latest 
version of the software.  This will download all necessary files and correctly 
install the upgrade. 

Click this button to Update to Latest Version.  

Please note:  your PC must be connected to the internet in order to check for 
updates. 

Check for Updates Before Starting RealFlight- 
If you check this box, every time you run the RealFlight G4 software it will 
check to determine whether or not there is a more recent version of RealFlight 
G4 available to you.  If a new version exists, RealFlight G4 will ask if you wish 
to download and install the newer build. 

Please note:  your PC must be connected to the internet in order to check for 
updates. 

Update to Specific Version- 
If you are experiencing difficulties with a version you have installed, this will 
allow you to retrieve a previous version of the software.  If the previous 
version fixes your problem, please contact our technical support team at 
rfsupport@greatplanes.com and let them know about the difficulty 
encountered. 

Clear Download Cache- 
Occasionally, files may become corrupt during a download.  If you are having 
difficulties with the online updates, remove all cached files using this option.  
Next, choose Update to Specific Version and then select the Completely 
Refresh option. 
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Uninstalling RealFlight- 
Click the Uninstall RealFlight button to uninstall the software.  The following dialog 
will appear: 

 

We suggest that you use this method, not the “Add/Remove Programs” feature in 
Windows, to uninstall RealFlight G4.  The RealFlight G4 launcher will remove all 
necessary RealFlight G4 files. 

Uninstall Program- 
Choose this option to uninstall only the RealFlight G4 program itself. 

Uninstall Data Files- 
Choose this option to uninstall any user files such as customized airports, 
customized aircraft, color schemes, songs etc.  Be careful with this option!  You 
could lose a lot of your work by inadvertently uninstalling these files. 

Remove Serial Numbers- 
Choose this option to remove the serial numbers from your system.  You have 
two options available if you check this box. 

• For this product only 

• For all RealFlight products, including Expansion Packs, older RealFlight 
editions, and Add-Ons 

 
Remove All Cached Files From The Online Update- 
Choose this to option to remove all cached download files from your system.  
If you uninstall these files, future downloads may take a little longer. 
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View Web Site- 
Click the View Web Site to visit the RealFlight web site.  A browser window will open 
for you and you will be automatically directed to the site.  

Please note:  your PC must be connected to the internet in order to view the RealFlight 
web site. 

Read Help File 
Press the Read Help File button to bring up the manual, this document that you are 
reading now, file for RealFlight G4. 

Technical Support- 
Press the Technical Support button to bring up technical support information 
pertaining your system.  If you encounter any difficulties with RealFlight, this 
information can help you to resolve the situation on your own, or may assist Great 
Planes’ Support Staff to diagnose the problem. 

 

System Information 
This displays a list of the critical system information.  Before you email 
technical support, or report a bug with the software, please be sure to cut and 
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paste this information into your email.  This will greatly assist them in 
diagnosing the difficulty. 

Reinstall DirectX 
Choose this option to reinstall DirectX.  Occasionally this will fix corrupted 
installations. 

Enter Technical Support Code 
Choose this option to enter a technical support code.  If you do encounter 
problems running RealFlight, our Technical Support team may supply you 
with a code to input here.  Entering this code will help them diagnose or 
resolve your difficulty. 

 

Email Technical Support 
This gives you the email address rfsupport@greatplanes.com to which you can 
email your difficulties.  If you do email us, please be sure to attach the 
Assemble System Information output to your email. 

You will receive an auto-reply message back confirming that Great Planes 
Support Staff received your email.  If you do not receive the auto-reply 
message, please double-check that you sent your email to the correct email 
address. 

Assemble System Information 
Choose this option to collect critical information about your system, and about 
your RealFlight settings.  You may find this information useful if you try to 
troubleshoot problems on your own.  Moreover, if needed you can cut and 
paste this information into an email to Great Planes Support Staff.   
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View Web Technical Support- 
Choosing this option will open a browser window, and take you to a web site 
that contains the most up-to-date technical support information for RealFlight 
G4. 

View Tasks- 
This shows you a list of all tasks that are running on your computer.  Some 
tasks can interfere with RealFlight G4 and may need to be closed. 

Include Serial Numbers- 
Check this box if you plan to assemble all system information to send to Great 
Planes Support Staff.  If you are sending this information to anyone else, don’t 
check this box.  The serial numbers are unique to you, and should only be 
shared with Great Planes Support Staff. 
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DX Diagnostics- 
This brings up Microsoft’s DXDIAG utility.  Using this utility can further help 
diagnose your system. 

Important:  if you send us information about your system to help us diagnose a 
problem, please do not use DXDIAG to generate that information.  Instead, 
please use the “Assemble System Information”.  The “Assemble System 
Information” output file contains more information than the DXDIAG 
output. 

MSInfo- 
This option will run MSInfo.  This will give you even more information about 
your system.  This program is not always installed a particular computer, but 
normally comes with programs such as Microsoft Office®. 

Display Properties- 
This brings up the display properties for your monitor.  You can use this page 
to change the resolution of your desktop. 

Explorer- 
This button launches Windows Explorer.  This Microsoft Windows utility can 
help you locate, move and backup your files. 

Launch Device Manager- 
This button launches the Device Manager.  This Microsoft Windows utility 
will help you determine driver dates, as well as installing and updating video 
and sound card drivers. 
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If You Experience 
Difficulties 
Tips and tricks for solving the more common problems. 

he RealFlight G4 simulator is on the cutting edge of technology, and therefore 
operates using advanced hardware.  Consequently, there is always the remote 
possibility you may experience a few slight difficulties.  Should the need arise, 
we provide extensive resources to help. 

Besides providing the best R/C simulator, we sincerely feel that we provide the best, 
most extensive product support for any R/C simulator.  Since cards, drivers, and 
operating systems are always changing, we work hard to keep our support team up-to-
date on the latest information available to ensure that you have the most enjoyable 
experience possible. 

This section begins with a summary of the various sources of RealFlight G4 
information including support and problem solving assistance.  Then, we will show 
you some simple but powerful steps that can resolve or prevent most RealFlight G4 
difficulties.  Finally, if these steps fail to solve your difficulty, we will explain the most 
effective ways to acquire additional assistance. 

 

How to Get Help and Information 
 
As a RealFlight G4 user, you have access to an incredible amount of information about 
this product.  Much of this information can help you resolve difficulties, or correctly 
access and use program features.  Here is where you can find it: 

• The manual.  Most common RealFlight difficulties can be resolved by following 
the instructions in later sections of this chapter.  However, there is also additional 
information throughout other chapters that may be of assistance. 

Appendix
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• Visit our product Knowledge Base at http://www.gpsoftware.com.  This is a great 
resource and is an indexed, searchable collection of articles that describe solutions 
to almost every known situation with RealFlight, RealRace, and all of our other 
software products.  In fact, this is the same information database used by our 
product support technicians.  

• Visit the Knife Edge Software Message Boards at 
http://www.knifeedge.com/forums/.  This is a place where owners of RealFlight, 
RealRace, and other Knife Edge products post questions, comments and 
responses.  Sometimes our product support technicians and product developers 
from Knife Edge post replies and announcements as well.  You may find a thread 
that discusses the same difficulties that you are experiencing.  

• Contact our Technical Support department by email at: 
rfsupport@greatplanes.com.  Alternatively, our staff is also available via telephone 
or postal mail at: 

 
RealFlight Technical Support 
3002 North Apollo Drive 
Suite #1 
Champaign, IL 61822 
Voice phone: (217) 398-8970(Option 1) 
FAX: (217) 398-7721 

The product support teams are specially trained, and have many resources to help 
you resolve problems with RealFlight G4. 
 

 

Before You Do Anything Else 
 
If you are experiencing difficulties with RealFlight G4, you should always try the steps 
below first.  These steps really do cure most problems our users experience.  Even if 
you are not having a problem, these same steps often assist in the operation of both 
RealFlight and your computer. 

Here are the steps you should take (instructions for each step follow): 

• Update your video and sound card drivers (see instructions below). 

• Update to the latest version of RealFlight G4. 

• If the problem persists, run the DirectX test programs. 

• If these steps do not work, proceed to the next section. 
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Update Your Drivers- 
Before you do anything else, you should make sure you have updated your video and 
sound drivers.  A large number of difficulties encountered by RealFlight users can be 
cured by updating drivers. 

A driver is a software program that controls your video or sound card.  Each card 
manufacturer provides drivers for its own cards.  To work correctly, RealFlight relies 
on your video and sound card drivers. 

It is very important to use the latest available driver for your card.  Card manufacturers 
frequently release updated drivers to fix problems that occur when the driver is used 
with programs such as RealFlight G4.  The driver that came with your new computer, 
on your Windows CD-ROM, or on a CD-ROM included with the new card you 
bought, may not be the latest version. 

If you do not know how to update drivers, you can find instructions in our Knowledge 
Base article Q01-1038, How to Update Drivers, at http://www.gpsoftware.com/kb/q01-
1038.htm.  This page will take you through the process step-by-step, and has links to 
driver download sites for most manufacturers. 

Update to the Latest Version of RealFlight G4- 
As we regularly release program updates, the difficulty that you are seeing may already 
be fixed in an update.  Even if you just bought RealFlight, you should update to the 
latest version.  It’s free and only requires a few minutes of your time. 

Run the DirectX Test Programs- 
If you have updated your drivers and RealFlight to the latest versions, and your 
problem persists, you should try to run the DirectX samples that come with RealFlight. 

The DirectX samples (DirectDraw, Direct3D, Sound, etc.) are test programs written by 
Microsoft.  These samples ship with DirectX, and are designed to check whether your 
DirectX installation, video/sound cards and drivers, etc., are working correctly.  They 
should work on any DirectX 9 compliant driver. 

These samples are found in the Technical Support area of the software.  Click the 
Technical Support button followed by the DX Diagnostics button.  Next, click either 
the Sound or the Music tabs, then the Test DirectX Music/Sound buttons.  Once 
these tests have been completed, press the Display tab to access the Test DirectDraw 
and TestDirect3D buttons. 

The most important tests are DirectDraw and Direct3D, both of which test your video 
card and driver.  If you are having any graphics difficulty in RealFlight G4 (including 
RealFlight G4 “freezing” your system so that you have to reboot), look for the same 
problem in these tests.  If the problem occurs only after you have run RealFlight G4 
for a long time, make sure to run the tests for a comparable length of time. 
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If your RealFlight G4 problem also occurs in Billboard, the problem lies with your 
video driver, not RealFlight G4.  To resolve the problem, try finding updated drivers 
for your card (see above).  If the problem still occurs with the latest drivers, you will 
need to report this problem to the card manufacturer.  Be sure to tell them that you 
tested the card by using Billboard.  Please note:  in rare cases, a newer video driver may 
have more problems than a previous version.  After exhausting all other options, you 
might try obtaining an older driver from the manufacturer to eliminate this possible 
cause as well. 

 

If You Need Additional Assistance 
 
If you have updated drivers and updated RealFlight G4, your system successfully runs 
the DirectX sample programs, and you are still having problems.  What next? 

As a first step, we suggest checking our Knowledge Base at 
http://www.gpsoftware.com.  This is an easy to use, searchable, browsable database of 
known problems and solutions for RealFlight, RealRace, and our other software 
products.  This is the same database that our Product Support technicians use when 
helping customers.  We constantly update the knowledge base to address new 
problems as we discover them.  In many cases, you will be able to find an article that 
gives clear, concise instructions for resolving your difficulty. 

You may also want to check the Knife Edge Message Boards at 
http://www.knifeedge.com/forums/.  This is a place where owners of RealFlight, 
RealRace, and other Knife Edge products post questions, comments and responses 
about problems.  You may find a discussion thread about the problem you are 
experiencing. 

You can also contact Technical Support at Great Planes via email at: 
rfsupport@greatplanes.com. 

IMPORTANT.  If you do contact Technical Support, you can help us enormously by 
providing detailed information about your computer system.  Since your problem may 
only occur on a particular video or sound card, particular driver version, etc., we may 
need this information to help us diagnose your problem.  To compile your system 
information, use the RealFlight G4 Launcher.  Click the Additional Options button.  
Next, click the Technical Support button, followed by the Assemble System 
Information button.  This will create a file called “c:\launcheroutput.txt”, which 
contains your system information.  Attach this file to an email and send it to us at 
rfsupport@greatplanes.com. 
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Examples of Common Problems and Solutions 
 
If You Don’t See Your Problem in This Chapter- 
This chapter contains a few examples of common difficulties and concerns that 
RealFlight users have experienced. 

Remember that we can never provide a complete list of difficulties and solutions in a 
program manual.  That’s because RealFlight--and the computers, cards and drivers it 
uses--are constantly evolving.  As such, we maintain a detailed Knowledge Base at 
http://www.gpsoftware.com.  By keeping our Knowledge Base online, we can provide 
you with the latest information about resolving any difficulties that might arise.  If you 
don’t see your difficulty described in this chapter, please check the Knowledge Base. 

In this chapter, we’ve simply tried to pick a very short list of the most asked about 
issues. 

My computer “freezes” when I run RealFlight- 
Sometimes, you may also notice sound skipping or repeating, or a computer reboot 
while flying.  To resolve this type of problem, you must update the drivers for your 
video and sound cards.  This is very important.  Card manufacturers regularly update 
their drivers to fix this type of problem.  Even the driver that came with your new 
computer may not be the most recent. 

Sometimes a card manufacturer will offer a choice between a “recommended” driver, 
and another driver (variously called “special purpose”, “alternate”, or “beta” driver).  If 
RealFlight G4 “freezes” with the “recommended” driver, try using the alternate driver 
instead. 

If you are sure that you are using the latest drivers, and have followed all the other 
steps in the previous section (update RealFlight G4, test DirectX) and are still having 
difficulty with your computer locking up while running RealFlight, please contact Great 
Planes Technical Support. 

Improving RealFlight G4 Performance- 
During installation, RealFlight G4 analyzes your computer’s hardware specifications.  
RealFlight G4 then tries to optimize its configuration to best take advantage of that 
hardware, and achieve the best possible performance. 

However, if the performance is less than you desire, you can adjust some of RealFlight 
G4’s settings to improve the simulation speed and frame rate: 

• Ensure that the drivers for the video and sound cards are up-to-date. 

• Turn off all other programs, especially virus checkers and network applications 
(such as Instant Messengers) while running RealFlight G4.  Use CTRL-ALT-
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DELETE and check the Task Manager to verify that nothing else is running in 
the background. 

• Reduce the texture and water quality.  This can have a profound effect on cards 
that do not have a high texture memory.  See the Settings section starting on page 
75 for more information. 

• Eliminate the items shown in the simulation.  To do so, access the View menu title, 
then access the Show menu item.  Click an item type to remove it from the 
simulation.  It may be necessary to eliminate several items before performance 
meets your expectations. 

• Reduce the number of open Gadgets and Viewports.  Click the ‘X’ on each Gadget 
or Viewport that you wish to close. 

• Reduce the number of recordings currently in use. 
 
Other Common Problems- 
Here are some other things you may want watch for. 

• Check the CD-ROM for scratches or blemishes.  Even minor scratches or 
fingerprints can cause random problems that appear to be program bugs. 

• Make sure your hard drive has at least 500 MB of space available.  To check this: 
1. Double click on the My Computer icon on your desktop 
2. Right click on your main hard drive (usually drive “C:\”) 
3. When the popup menu appears, select Properties 
4. In the dialog that appears, view the amount of space available on the drive 
 
If you need additional space, try emptying the Recycle Bin. 

• Verify that all other programs are closed prior to starting RealFlight G4.  RealFlight 
works best when it is the only program running. 

• If all else fails, try rebooting your computer.  Occasionally, Windows (particularly 
98 and ME) may become unstable after prolonged and continuous use.  A simple 
reboot may clear up any difficulties.
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Glossary 
 

180-Degree Turn 
R/C Term 

This basic flight practice starts with a takeoff, and 
then demonstrates 180 degree turns on a flight path 
parallel to the runway. 

360-Degree Turn 
R/C Term 

In this practice, you will learn to fly the aircraft in a 
complete circle (360-degree turn).  This maneuver is 
a great way to learn control inputs for turns while 
keeping the same radius and altitude. 

3D Acceleration 
Computer Term 

3D operations require a huge number of 
calculations.  Modern computers offload many of 
these calculations to the video card, rather than 
performing the calculations directly on your 
computer's CPU.  This speeds up the simulation 
and allows for faster frame rates, thereby increasing 
the realism of the simulation. 

ATV 
R/C Term 

Amount of servo travel. For instance, 50% ATV 
would mean the servo's maximum travel is 50% of 
its physical limit. 

AccuModel 
RealFlight Term 

RealFlight G4’s AccuModel aircraft editor offers the 
most powerful, most flexible aircraft editor ever 
released in an R/C simulator. 

Active View 
RealFlight Term 

The active view is the view that is affected by the 
commands in the View menu.  Only one view at a 
time is active.  You can make a view active by 
clicking on it with the mouse.  When you want to 
control a view’s properties, you must first make it 
the active view. 

Advanced Flight Recorder 
(AFR) 
RealFlight Term 

This feature allows the pilot to not only view 
prerecorded maneuvers, but also allows them to 
record their own.  During the playback of 
maneuvers, the pilot has the ability to select from a 
number of different options such as fast forwarding, 
rewinding, looping, speeding up and slowing down 
the recordings.  These recordings may also be sent 
to others via the internet.  The pilot can also activate 
an on-screen transmitter to watch the stick inputs 
for each pre-recorded maneuver. 
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Adverse Yaw 
R/C Term 

The tendency of an airplane to yaw in the opposite 
direction of the roll. For instance, when right aileron 
is applied, the airplane yaws to the left, thus 
opposing the turn. Adverse yaw is common in 
trainer type airplanes having flat bottom wings. It is 
most noticeable at slow speeds and high angles of 
attack, such as during takeoffs and when stretching 
a landing approach. Caused by the unequal drag of 
the upward and downward deflection of the 
ailerons, this undesirable trait can be minimized by 
setting up the ailerons with Differential Throw or 
by coordinating the turns, using the aileron and 
rudder controls simultaneously. 

Aileron 
R/C Term 

Hinged control surfaces located on the trailing edge 
of the wing, one on each side, used to provide 
control of the airplane about the roll axis.  The 
control direction is often confusing to first time 
modelers.  For a right roll or turn, the right hand 
aileron moves upward and the left hand aileron 
moves downward.  The movements are reversed 
for a left roll or turn. 

Airfoil 
R/C Term 

A surface (such as a wing or propeller blade) with a 
shape and orientation such that it provides or 
controls stability, direction, lift, or propulsion. 

Airframe 
RealFlight Term 

A term used to describe the general components of 
an aircraft when using RealFlight G4’s AccuModel 
aircraft editor.  For example, selecting the airframe 
will call up the fuselage, wing(s) and tail of an 
airplane. 

Angle of Attack 
R/C Term 

The angle that the wing penetrates the air. As the 
angle of attack increases so does lift and drag, up to 
a point. 

Arm 
R/C Term 

In this context, the arm is the distance from the 
point of the application of a force to the axis of 
rotation.  If you press down on the tip of a wing, for 
example, the arm is the distance from the point 
where you are pressing to the root of the wing. 

Auto-Play 
Computer Term 

A Windows feature that automatically detects when 
a CD-ROM is inserted and runs the specified 
program on the CD-ROM. 
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Autorotation 
R/C Term 

A maneuver in which the pilot attempts to bring the 
helicopter in for a landing without power from the 
engine.  The momentum of the spinning rotor 
blades is enough to slow the helicopter prior to 
landing. 

Autorotation Event 
RealFlight Term 

An event where players attempt to autorotate onto a 
target (similar to Spot Landing).  Each player takes a 
turn.  Players collect different point amounts based 
on landing location.  The Autorotation Event works 
for helicopters only.  The Deadstick Event is for 
airplanes. 

Avalanche 
R/C Term 

The Avalanche is a loop with a snap roll at the top 
of the loop.  This snap roll must be centered at the 
top of the loop. 

Bloom Effect 
RealFlight Term 

The effect creates a feathering of light around 
brighter objects, giving it a more realistic look.  This 
is more noticeable at brightly lit airports around 
aircraft that are lighter in color. 

Channel Mapping 
RealFlight Term 

This term describes the ability of RealFlight G4 to 
alter the mapping or input of the servos to 
accurately reflect the actual controls from an R/C 
controller. 

Chat 
RealFlight Term 

This is a real-time communication between two G4 
users which is conducted via the PC.  G4’s 
multiplayer feature enables a public chat if so 
desired. 

Child/Children Item(s) 
RealFlight Term 

In many of RealFlight G4’s selection windows, 
items are displayed in a hierarchy format.  An item 
that belongs to a higher group, or parent, is 
considered the child item.  

Chord 
R/C Term 

The chord of a wing or surface is the width of the 
surface.  A wider chord offers increased lift.  
However, a wider chord also generates more drag 
when the aircraft rolls. 

CG 
R/C Term 

CG is the abbreviation for the phrase Center Of 
Gravity.  This is the point at which the aircraft 
balances fore to aft and side-to-side.  The location 
of this point is crucial to how the aircraft reacts in 
the air.  For airplanes, a tail-heavy plane will be very 
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snappy, but generally unstable and susceptible to 
frequent stalls.  Conversely, a nose-heavy plane will 
tend to track better and be less sensitive to control 
inputs, but will generally drop its nose when the 
throttle is reduced to idle.  This makes the plane 
more difficult to land, since it takes more effort to 
hold the nose up.  A nose heavy airplane will have 
to come in faster to land safely. 

Collective 
R/C Term 

A mechanism on a helicopter that changes the pitch 
of the main blades, thereby allowing the helicopter 
to ascend or descend accordingly. This is the 
control that adjusts the pitch of the rotor blades. 

Collision Detection 
RealFlight Term 

RealFlight G4 sports the most advanced collision 
detection modeling ever used in an R/C model 
simulation.  It blankets the entire aircraft, ensuring 
accurate modeling of the aircraft when it collides 
with objects and items within the simulation. 

Coning 
R/C Term 

When a helicopter hovers, the blades form a slight 
"cone" when viewed from the side. The Coning 
effect is caused by the balance between lift and 
centrifugal forces on the blades. 

Control Surface 
R/C Term 

Generally defined as the portion of the airfoil that 
moves.  Examples include ailerons, elevators, 
rudders, flaps, and spoilers. 

Controller 
RealFlight Term 

A device used to control an aircraft in RealFlight.  
G4 ships with the Great Planes’ USB InterLink 
Elite Controller by Futaba.  This device can be used 
as a standalone controller, or as an interface to use 
your own R/C transmitter.  Previous versions of 
RealFlight shipped with either a Futaba game port 
controller or a Transmitter Adapter Interface.  For 
information on the latter two controllers, please see 
the manuals that came on the program CD with 
those versions of RealFlight. 

Cuban Eight 
R/C Term 

This maneuver requires that the pilot perform a half 
roll on each of the descending forty-five degree 
down lines, allowing the pilot to fly a horizontal 
figure eight without performing an outside loop. 

Cyclic 
R/C Term 

Refers to the changing of a main rotor blade's pitch 
as the rotor head rotates. Pitch is added while the 
blade is pointing in one direction (e.g. while the 
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blade is over the canopy), and removed while the 
blade is pointing the the opposite direction (e.g. 
while the blade is over the tail boom). This causes 
the helicopter to pitch and roll. 

Data Lever 
RealFlight Term 

RealFlight G4’s InterLink Elite has the ability to 
make on-screen selections, or quickly look at the 
windsock or ground.  This can be done with the 
Data Lever, located at the bottom right-hand corner 
of the InterLink Elite controller. 

Deadstick 
R/C Term 

A term used to describe unpowered flight (glide) 
when the engine ceases operation. 

Deadstick Landing Event 
RealFlight Term 

See Autorotation Event.  The Deadstick Landing 
Event is specific to airplanes. 

Dihedral 
R/C Term 

The V-shaped bend in a wing.  Increasing the 
dihedral usually enhances the aerodynamic stability 
of an airplane, and causes the rudder to control 
both the roll and yaw axis.  This is why some 
trainers and sailplanes require only three channels of 
radio control (i.e., they have no ailerons). 

Direct Control Interface 
RealFlight Term 

This is a method for using your own radio to 
completely control the aircraft.  This usually means 
you have a separate radio program on your radio for 
each aircraft that you want to fly in RealFlight G4 
with this method.  All mixing and radio functions 
are performed on your radio and RealFlight simply 
passes the values directly to the aircraft servos.  This 
is in contrast to the Joystick Emulation Interface. 

Direct3D Technology 
Computer Term 

A Microsoft DirectX technology used to render the 
3D image when you have a graphics accelerator 
card.  It works best on faster computers. 

DirectX 
Computer Term 

A technology created by Microsoft that controls 
graphics and sound operations. 

Dithering 
R/C Term 

A method of removing and/or simulating colors 
that may not be available to the graphics processing 
unit. 

Down Thrust 
R/C Term 

This is the downward angle of the engine in 
relationship to the centerline of the airplane.  Down 
Thrust helps overcome the normal climbing 
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tendency of flat bottom wings. 

Driver 
Computer Term 

A software program that controls a card (e.g., video 
or sound card) in your computer.  Card 
manufacturers usually provide drivers as well.  Card 
manufacturers frequently update their drivers to fix 
bugs or to make their cards compatible with new 
software and hardware.  You can often find an 
updated driver for your video or sound card by 
visiting the card manufacturers web site and 
following links to “Drivers,” “Support,” 
“Downloads”, or “Upgrades.” 

Edit NavGuides 
RealFlight Term 

A NavGuide is a gadget that displays continuously 
updated information about your aircraft.  The Edit 
NavGuides dialog is used to customize the 
NavGuides gadgets. 

Elevator (Maneuver) 
R/C Term 

The Elevator is a maneuver in which the aircraft is 
made to stall completely with a large amount of 
elevator throw.  The aircraft will descend almost 
vertically much like an elevator. To perform the 
Elevator, make sure that you have sufficient altitude, 
dive the aircraft vertically towards the ground and 
pull full up on the elevator stick. 

Elevator (Control Surface) 
R/C Term 

Hinged control surface located at the trailing edge 
of the horizontal stabilizer, which provides control 
of the airplane about the pitch axis and causes the 
airplane to climb or dive.  The correct direction of 
control is to pull the transmitter Elevator control 
stick back, toward the bottom of the transmitter, to 
move the Elevator upward, which causes the 
airplane to climb.  Move the Elevator in the other 
direction to dive. 

Endpoint Adjustment 
R/C Term 

This radio feature adjusts the length of servo travel 
in one direction (a single channel will have 
adjustments for two endpoints). If, for example, 
your aircraft rolls faster one way than the other, 
endpoint adjustments can correct the problem. 

Event 
RealFlight Term 

An organized flying contest with a set of rules.  
RealFlight G4 currently supports five types of 
Events:  Limbo, Spot Landing, Pylon Racing, 
Autorotation/Deadstick and Freestyle.  You can 
participate in Events by yourself or with other 
RealFlight users over the internet.  Use the Event 



 

 299

menu to start an Event. 

Exponential 
R/C Term 

A feature commonly found on computer radios that 
desensitizes the servo when the sticks are close to 
the neutral position.  The further the stick position 
from center, the faster the control response. 

Figure 8 
R/C Term 

This is an excellent maneuver to learn perspective 
and orientation of the aircraft from all angles.  Use 
the ailerons and elevator to turn the aircraft left and 
right.  Use the elevator to ensure that the aircraft 
maintains a constant altitude, forming an ‘8’ in the 
sky. 

Flap 
R/C Term 

For Airplanes:  hinged control surface located at the 
trailing edge of the wing inboard of the ailerons.  
The Flaps are lowered to produce more 
aerodynamic lift from the wing, allowing a slower 
takeoff and landing speed.  Flaps are often found on 
scale models, but usually not on basic trainers. 

For Helicopters:  Flapping is an up-and-down 
motion of the main rotor blade's tip.  With a "dual-
damped" head, (as used in the Kyosho Concept 
helicopters, for example) both blades are able to 
Flap independently.  With "solid axle" heads (as 
used in the Hirobo Shuttle helicopters, among 
others), moving one blade up causes the other to 
move down. 

Flapping Head 
R/C Term 

This describes a type of rotor head in which the two 
blades are not connected directly. Each blade is 
independent of the other, usually resulting in a 
helicopter with smoother performance. 

Flare 
R/C Term 

The point during the landing approach in which the 
pilot increases the amount of up elevator to smooth 
the touchdown of the airplane. 

FlexiField 
RealFlight Term 

FlexiField is the most advanced flying site editor 
ever unveiled.  It presents the modeler with the 
ability to adjust the flying site in virtually any 
manner desired.  The user can add trees, selecting 
the type, size and color; add, move, size and orient 
buildings, walls and other scenery objects; position 
and orient the runway; even choose the amount and 
type of lighting at the flying site. 
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Flight Failures 
RealFlight Term 

RealFlight G4 authentically recreates common 
difficulties that may be experienced at your local 
flying site.  Practicing with flight failures enabled is a 
good way to practice for emergencies. 

Flight Playback Gadget 
RealFlight Term 

A gadget that lets you control playback of flight 
recordings using mouse actions. 

Float Fly 
R/C Term 

The ability to takeoff and land a radio controlled 
aircraft from water. 

Flybar Paddles 
R/C Term 

These are the short blades on the end of the flybar. 
Available in a variety of weights and airfoils, these 
paddles assist the main blades in producing lift, etc. 

Four-Point Roll 
R/C Term 

These maneuvers are very similar to a slow roll with 
the exception of a hesitation at either ¼ of the roll 
or at 1/8 of the roll.  It is important to remember to 
use rudder and elevator to keep the aircraft flying in 
a straight line. 

Frame Rate 
Computer Term 

Frame Rate is the number of times per second that 
RealFlight creates a different picture to display on 
your monitor.  Frame rate is determined by the 
speed of your CPU and graphics card, and how 
many RealFlight options you turn on.  This is not 
the same as refresh rate, which is the number of 
times per second that your monitor retraces an 
image on its screen. 

Freestyle Event 
RealFlight Term 

An event where players decide on the rules.  
RealFlight G4 sees that each player gets a turn; it is 
the players’ responsibility to judge the competition.  
Use this event when you have devised a group 
activity that requires every player to take a turn. 

Fuselage 
R/C Term 

Generally speaking, this is the main part of the 
airplane that holds the wings and engine.  The 
fuselage is often thought of as the “body” of the 
airplane.  This term is also used to refer to a “body” 
that might be used on helicopters. 

Futaba 
R/C Term 

Maker of high quality R/C products, including the 
USB InterLink Elite controller shipped with 
RealFlight G4. 

Gadget 
RealFlight Term 

An on-screen display that shows you continuously 
updated information about your aircraft, or lets you 



 

 301

control RealFlight features using mouse clicks. 

Global Wind 
RealFlight Term 

This term describes the overall wind conditions in 
the simulation. 

Governor 
R/C Term 

A device used to help maintain a constant RPM 
(head speed).  Generally used in helicopters rather 
than airplanes. 

Grouping 
RealFlight Term 

A collection of scenery objects or foliage objects in 
your airport.  Every object in the airfield must 
belong to one Group.  You can place all of your 
airport's scenery objects in a single Group, or create 
multiple Groups to place objects in categories with 
related objects.  For example, you could have a 
Group for Trees and another group for Buildings 
within a particular airport. 

Gyro 
R/C Term 

A device, most commonly used in helicopters, that 
aids in controlling the yawing action of the 
helicopter by automatically adjusting the deflection 
of the tail rotor blades. 

HAL Device 
Computer Term 

A hardware-accelerated 3D video card driver.  
“HAL” is an abbreviation for the phrase “Hardware 
Abstraction Layer” that uses software drivers to 
communicate between RealFlight’s software and the 
hardware of the PC. 

Harrier 
Computer Term 

A Harrier is a slow forward progression of the 
aircraft with the nose held high.  Use the elevator to 
stall the forward progress of the aircraft.  Add in 
more up elevator until the nose approaches 45 
degrees.  The throttle should be used to control the 
forward progress of the aircraft, without climbing. 

Host 
RealFlight Term 

In RealFlight G4, every multiplayer session requires 
one player to serve as Host.  The Host starts the 
session, and then the other players join.  Other 
players can leave the session whenever they want, 
but only the Host can terminate the entire session.  
The Host must start any multiplayer event (Limbo, 
Spot Landing, Pylon Racing, Autorotation, 
Freestyle). 
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Hot Pluggable/Hot 
Swappable 
Computer Term 

A device is said to be Hot Pluggable or Hot 
Swappable when you can safely connect or 
disconnect it without turning off your computer or 
rebooting. 

Hub 
R/C Term 

The centralized mechanical device used to attach 
the main rotor blades and paddles. 

Humpty-Bump 
R/C Term 

This aerobatic maneuver consists of two vertical 
lines connected by a half circle flown across the top. 

IP Address 
Computer Term 

Whenever your computer is connected to the 
internet, it has an IP address.  This number is a 
string of digits and periods, and looks something 
like “123.45.6.78”.  The IP address is like an internet 
“zip code” that tells other computers where to look 
for your computer.  Depending on your internet 
connection, your IP address may always be the 
same, or may change each time you connect to the 
internet.  For other RealFlight G4 users to join your 
Multiplayer session, they must obtain your IP 
address.  You can either provide it to them directly, 
or post it through the RealFlight list server. 

Immelman Turn 
R/C Term 

The aircraft will enter a half loop from straight and 
level flight followed immediately by a half roll to 
straight and level flight. 

Interface Mode 
RealFlight Term 

With RealFlight G4 set to Interface Mode, you are 
using the InterLink Elite Controller as an interface 
to your own R/C radio.  In Interface Mode, your 
own radio controls RealFlight G4.  Conversely, in 
Joystick Mode the InterLink Elite Controller (used 
as a mockup of a R/C transmitter) controls the 
RealFlight G4 aircraft. 

InterLink Elite Controller 
RealFlight Term 

Great Planes’ USB InterLink Elite Controller by 
Futaba is a USB device shipped with RealFlight G4.  
The InterLink Elite Controller can be used as a 
standalone “mockup” R/C controller, as an 
interface for using your own R/C transmitter to 
control RealFlight, or both simultaneously! 

Joystick 
Computer Term 

A device that connects to your computer to provide 
control input for the simulated aircraft.  The 
InterLink Elite controller that comes with 
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RealFlight G4 is considered a Joystick. 

Joystick Emulation Interface 
RealFlight Term 

A term used to describe using your own radio to 
emulate the Interlink Joystick.  This allows you to 
use your own radio to fly any of the stock aircraft in 
RealFlight G4.  Actual radio functions such as 
mixing and ATVs are performed in the RealFlight 
software, not on your radio.  This is in contrast to 
the Direct Control Interface. 

Joystick Mode 
RealFlight Term 

With RealFlight G4 set to this mode, RealFlight G4 
is controlled by the InterLink Elite controller used 
as a mockup of a R/C transmitter. 

Launcher 
RealFlight Term 

The RealFlight G4 Launcher is useful for many 
aspects of the G4 program, including loading the 
simulator, compiling system information for 
technical support, or uninstalling RealFlight. 

LAN 
Computer Term 

Local Area Network. This is usually a network 
where the computers are connected with high speed 
network cards. 

Lead Lag 
R/C Term 

A helicopter term describing the hinge point where 
the blade attaches to the hub. This allows the blade 
to move forward and backward at certain times 
during the blades rotation. 

Leading Edge 
R/C Term 

The very front edge of the wing or stabilizer. This is 
the edge that hits the air first. 

Limbo 
R/C Term 

An event (flying competition) in which pilots take 
turns flying their aircraft under a Limbo bar.  The 
pilot that clears the lowest bar height wins. 

List Server 
RealFlight Term 

RealFlight G4’s Multiplayer function lets you 
publicly “post” your session, so that any RealFlight 
G4 user, anywhere in the world, can find out about 
your session and join you (assuming you have not 
reached the enrollment limit of your session).  The 
place where you post your session is called a List 
Server.  Use of the List Server is optional.  You can 
preserve privacy by not posting your session, and 
privately communicating your IP address to your 
selected multiplayer partners. 

Please note that the free, public list server for use by 
RealFlight owners may be modified or discontinued 
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without notice at any time. 

Low Rates 
R/C Term 

A switch on the radio that reduces the servo 
movement to much smaller extremes, thus making 
the model respond more slowly to a given control 
input. 

Mode 
R/C Term 

Also known as Flight Mode or Stick Mode, this 
refers to the transmitter's gimbal stick assignments 
(locations) which determine the flight mode of your 
controller. There are two main modes of control, 
Mode 1- mostly used in Europe and Mode 2 which 
is the predominant method of controlling aircraft 
commonly used in the United States. 

Most Recently Used (MRU) 
Computer Term 

MRU refers to the list of documents which were 
last accessed.  For RealFlight G4, MRU’s appear for 
airports, aircraft and recordings. 

MultiMode 
RealFlight Term 

A G4 feature that allows two users to fly 
simultaneously on the same PC. 

Multiplayer 
Computer Term 

A RealFlight G4 feature that uses Microsoft's 
DirectX technology to connect with other 
RealFlight G4 users over a network. 

Multiplayer Session 
RealFlight Term 

A network connection between RealFlight G4 users 
that allows each user to fly in the same "virtual 
world," and allows all participants to see and interact 
with each other's aircraft. 

NavGuides 
RealFlight Term 

A gadget that displays continuously updated 
information about your aircraft and the virtual 
world. 

Parent Item 
RealFlight Term 

In many of RealFlight G4’s selection windows, 
items are displayed in a hierarchy format.  An item 
that has additional item within it is considered the 
parent item. 

PhotoField 
RealFlight Term 

A technology that creates a flying field by using a 
panoramic photograph as a background for a flat 
terrain. 

Pirouette 
R/C Term 

The yawing action of a helicopter that looks much 
like an ice skater spinning in a circle.  One Pirouette 
is equal to one 360-degree rotation. 
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Pitch Axis 
R/C Term 

The airplane axis is controlled by the elevator.  Pitch 
is illustrated by holding the airplane at each wingtip.  
Raising or lowering the nose is the pitch movement.  
This is how the climb or dive is controlled. 

Plumb String 
R/C Term 

When you measure your aircraft for RealFlight, 
some measurements require that you have a 
reference line running straight up and down.  To 
make such a line, we tie a weight to the free end of a 
string, and let the weight dangle.  Because the string 
is then “plumb” (oriented straight up and down), it 
is called a Plumb String.  A Plumb String is 
particularly useful in measuring an aircraft’s center 
of gravity. 

Point Rolls 
R/C Term 

These maneuvers are very similar to a roll with the 
exception of a hesitation at either 1/4 or 1/8 of the 
roll. 

Private Session 
RealFlight Term 

A multiplayer session that is not published on our 
list server.  For a private session, the host must 
distribute his/her IP address to each participant, 
who must manually enter this information to join. 

Propeller 
R/C Term 

Props are generally designated by two numbers (for 
instance, “10 – 6”).  The first number is the length 
(10" in the example) of the prop.  The second 
number is the pitch or angle of the blades.  In this 
example, the “6” represents the distance the 
propeller will move forward in one revolution. 

Public Session 
RealFlight Term 

A multiplayer session that is published on a list 
server. 

Pylon Racing 
R/C Term 

An event (flying competition) in which pilots take 
turns flying their aircraft around a closed course.  
Pylons mark the course perimeter.  The pilot that 
finishes the course first wins. 

QuickSelect 
RealFlight Term 

RealFlight G4 InterLink Elite allows you to make 
changes to the simulator with the controller using 
the buttons at the bottom.  Manipulating these 
buttons through the on-screen QuickSelect tabs 
offer the ability to change aircraft, flying sites, and 
more. 
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RAM 
Computer Term 

Random Access Memory. 

ReadySelect 
RealFlight Term 

This is the name given to RealFlight G4’s rotating 
preview box.  This allows a rapid view of the aircraft 
from all angles. 

RealPhysics 3D 
RealFlight Term 

This is RealFlight’s exclusive physics modeling 
technology.  RealPhysics 3D authentically replicates 
the actual physics of model aircraft by performing 
hundreds of thousands of floating point calculations 
each second while delivering sizzling real time 
performance. 

Refresh Rate 
Computer Term 

The number of times per second that your monitor 
retraces an image on its screen.  This is different 
from the Frame Rate. 

Resolution 
Computer Term 

When used in the context of screen Resolution, this 
term describes the picture quality of the screen.  
Lower Resolutions will produce an image that is not 
as sharp as higher Resolutions. 

Roll Axis 
R/C Term 

The airplane axis controlled by the ailerons.  Roll is 
illustrated by holding the airplane by the nose and 
tail.  Dropping either wingtip is the roll movement.  
Roll is used to bank or turn the airplane.  In most 
airplanes, the ailerons control roll.  However, when 
the main wing has dihedral, the plane can be banked 
using the rudder only.  Consequently, many planes 
with wing dihedral do not have ailerons, and the 
rudder controls both roll and yaw.  This is one 
reason why most trainer aircraft have a large 
amount of dihedral -- a plane with large dihedral can 
be controlled using fewer input channels. 

Rolloff Factor 
RealFlight Term 

This phrase describes how rapidly the volume of a 
sound increases or decreases as the source draws 
closer or moves farther away. 

Root 
RealFlight Term 

In many of RealFlight G4’s selection windows, 
items are displayed in a hierarchy format.  The 
upper most item in this hierarchy is considered the 
Root item. 

Rudder 
R/C Term 

Hinged control surface located at the trailing edge 
of the vertical stabilizer, which provides control of 
the airplane about the Yaw axis (causing the airplane 
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to Yaw left or right).  Left Rudder movement 
causes the airplane to Yaw left, and right Rudder 
movement causes it to Yaw right. 

Servo 
R/C Term 

An electromechanical device that moves the control 
surfaces or throttle of an airplane according to 
commands from a receiver.  This device does the 
physical work of moving parts around inside the 
aircraft. 

Session 
RealFlight Term 

See "Multiplayer Session." 

Software Radio 
RealFlight Term 

This term describes RealFlight G4’s ability to 
accurately mimic a computer transmitter (complete 
with mixing, etc.) in the simulation. 

Sound Card 
Computer Term 

A card inside your computer that controls audio 
(what you hear over your computer speakers).  
Most sound cards plug into your computer’s 
motherboard.  You can upgrade your sound card 
(or the software driver that controls it) without 
getting a new computer. 

Specular Highlights 
Computer Term 

A graphics rendering technique that makes surfaces 
(e.g., MonoKote™) appear reflective, or “shiny”, in 
direct light (e.g., sunlight). 

Split S 
R/C Term 

The Split S is another step in learning to combine 
loops and rolls and is a great maneuver to decrease 
your altitude.  A half roll precedes a half loop, 
making the maneuver a mirror image of the 
Immelman.  The Split S provides course reversal 
and an easy increase in speed. 

Spot Landing 
R/C Term 

An event (flying competition) in which pilots take 
turns trying to touch their aircraft down within a 
small marked landing area.  Each pilot receives a 
score based on touch down location.  The pilot with 
the highest score wins the event. 

Stall 
R/C Term 

When an airplane’s angle of attack is too great to 
generate lift (regardless of airspeed), the plane will 
dive and rapidly lose altitude.  This is known as a 
stall.  Every airfoil has an angle of attack at which it 
generates maximum lift.  The airfoil will stall beyond 
this angle. 
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Swash Plate 
R/C Term 

The mechanism in a helicopter rotor that turns non-
rotating control movements into rotating control 
movements. 

Thermal System 
R/C Term 

This phrase describes the wind flow and effects for 
the thermals in RealFlight G4. 

Throttle Hold 
R/C Term 

This is used to keep the throttle at a set position, yet 
allows input to the collective of the helicopter. 
Generally this function is used to practice 
autorotation. 

Tip Stall 
R/C Term 

This is when the airplane reaches its stall speed and 
one wing drops. 

Torque Roll 
R/C Term 

The Torque Roll occurs when the nose of the 
airplane is pointed vertically and the airplane hovers 
in place.  The aircraft will rotate left around its roll 
axis. 

Touch and Go 
R/C Term 

Landing and taking off without a pause. Often 
confused with a good bounce. 

Trailing Edge 
R/C Term 

The rearmost edge of the wing or stabilizer. 

Trainer 
R/C Term 

A model designed to be inherently stable and fly at 
low speeds, to give first-time modelers time to think 
and react as they learn to fly. 

Training Aids 
RealFlight Term 

RealFlight G4 offers a variety of features to learn 
new maneuvers.  These consist of training aids that 
take you through, step-by-step, basic flight lessons, 
such as Takeoffs and Landings for airplanes, and 
Hovering practice for helicopters.  Pre-recorded 
lessons are also available from professional pilots. 

TruFlo Wind Dynamics 
RealFlight Term 

RealFlight G4’s TruFlo Wind Dynamics is the most 
accurate wind model ever released in an R/C 
simulator.  It combines five different wind models 
to recreate the ever-changing wind fields found at a 
real flying site. 

Turbulence System 
RealFlight Term 

This is the ability of RealFlight to induce turbulent, 
rough air, as would be experienced at the flying site. 

USB 
Computer Term 

USB, or Universal Serial Bus, is a connection 
protocol for computer peripheral devices (like Great 
Planes’ USB InterLink Elite Controller by Futaba).  
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USB technology allows you to connect multiple 
devices to your computer, and supports high data 
transfer rates and is hot swappable.  USB devices 
have a special connector that only fits into a USB 
port.  Most modern personal computers have USB 
ports, which are usually clearly labeled.  Some 
computers have one or more USB ports on the 
front of the computer housing, although the USB 
ports are usually on the back of the computer. 

Variometer 
R/C Term 

An instrument designed to indicate the rate of climb 
or descent of an aircraft. 

Video Card 
Computer Term 

A card inside your computer that produces the 
images on your video monitor.  Most modern 3D 
video cards have accelerated 3D operations—that 
is, they perform numerical calculations for rendering 
a 3D scene, to free up your computer’s CPU to 
perform other tasks.  The video card plugs into your 
computer’s motherboard.  You can upgrade your 
video card (or the software driver that controls it) 
without replacing your computer. 

Viewport 
RealFlight Term 

A picture-in-picture display set within the RealFlight 
G4 main display.  The Viewport is independently 
adjustable and serves as its own unique “window on 
the world”. 

Virtual Flight Instruction 
RealFlight Term 

This RealFlight G4 feature lets you choose from a 
variety of prerecorded maneuver training lessons.  
The maneuver is then demonstrated on screen, 
along with the instructor’s voice and control stick 
movements.  You can index, pause and even loop 
the maneuver playback for training purposes. 

VirtualRevolution 
RealFlight Term 

This is the exclusive sound technology used by 
RealFlight G4.  As with the original RealFlight 
programs, the sounds are Doppler-correct.  If the 
user’s sound card supports it, surround sound is 
also available. 

Washout 
R/C Term 

An intentional twist in the wing, which causes the 
wing tips to have a lower angle of attack than the 
wing root.  In other words, the trailing edge is 
higher than the leading edge at the wing tips.  
Washout helps to prevent tip stalls. 
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Waterfall 
R/C Term 

The Waterfall is a maneuver where the plane pivots 
360 degrees in the pitch axis with as little forward 
motion and altitude deviation as possible.  As the 
name suggests, this maneuver resembles a waterfall 
during flight. 

Wing Loading 
R/C Term 

The amount of weight per square foot that has to 
be overcome to provide lift.  It is normally 
expressed in ounces per square foot.  This 
specification can be easily calculated as follows:  first 
determine the area of the wing in square inches.  
Then simply divide by 144 to obtain square feet.  
Divide the total weight (in ounces) of the airplane 
by the wing area (in square feet). 

This information is valuable when deciding on 
which airplane to build next.  Planes with high wing 
loading must fly faster to stay in the air.  These are 
generally "performance" airplanes.  Conversely, a 
plane with lower wing loading does not need as 
much air flowing around the wing to keep it flying.  
Gliders and trainer airplanes fall into this category 
because in this case, slow, efficient flight is highly 
desirable. 

Yaw Axis 
R/C Term 

The airplane axis controlled by the rudder.  Yaw is 
illustrated by hanging the airplane level by a wire 
located at the center of gravity.  Left or right 
movement of the nose is the Yaw movement. 
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About, 262 
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AFR. See Advanced Flight Recorder 
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Airplane Hover Trainer, 216 
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Base, 209 
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Boot Player, 185 
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Brightness, 96 
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ColorSchemes, 126 
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PowerSpecularOff, 126 
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Specular, 126 
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Commit Line, 160 
Console, 80, 250 
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Controller. See InterLink Elite 
Controller Calibration, 135, 141 
Controller Menu, 133 
Crash Eliminates Player, 151, 156, 161, 171 
Crashing, 267 
Crosswind, 204, 208 
Cut Penalty, 165 
Cuts Allowed, 165 
Cyclic Stick, 273 

D 
Data Lever, 297 
Deadstick, 149, 152, 297 
Direction, 204, 209 
DirectX, 13, 289, 297 
Disconnect, 184 
Display Advanced Properties, 116 
Display Properties, 286 
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Distance Between Poles, 161 
Distance between pylons, 166 
Distance to Drop Bar, 160 
Downwind, 209 
Drivers, 12, 289, 298 

E 
Edit Airport, 31, 40 
End Current Event, 174 
Environment, 60 
Errors, 86 
Events Menu, 147 
Events Viewport, 154, 158, 163, 168, 173 
Export, 70, 74 

F 
Final, 209 
Fixed Position, 232 
FlexiField, 4, 30, 299 
Flight Failures, 5, 65, 89, 300 
Float Fly, 3 
Folder Listing Window, 51, 52 
Foliage Density, 94 
Forfeit Turn, 175 
Forward Flight, 276 
Freestyle, 154, 157, 300 
Futaba, 300 

G 
G Force, 252 
G3X. See RealFlight Archive 
Gadgets, 26, 194, 243, 300 
Global Wind, 301 
Graphics, 92, 245 
Graphics Frame Rate, 253 
Great Planes, 265 
Ground Speed, 252 
Grouping, 39, 49, 110, 301 
Gyro, 275 

H 
Head Tracking, 239 
Heading, 245, 252 
Height, 253 
Heli Hover Trainer, 209 
Heli Orientation Trainer, 222 
Helicopter Basics, 270 
Helicopter Physics. See Physics 
Help Contents, 260 
Help Menu, 259 
Host, 179, 183, 184 

Hovering, 276 
Hovering Training Aids, 3 

I 
Idle-Up, 275 
Import, 68 
Instructions, 81 
Interface Mode, 302 
InterLink Elite, 2, 4, 12, 13, 33, 134, 140, 

145, 302 
IP Address, 178, 183, 302 

J 
Join, 182 
Joystick Emulation, 142, 143, 303 
Joystick Mode, 140, 142, 303 

K 
Keep Ground in View, 236 
KEX, 69 
Keyboard Commands, 261 
Kill Engine, 129 
Knife Edge Software, 265 
Knowledge Base, 288, 290 

L 
LAN, 177, 303 
Landing Trainer, 3, 205 
Landings, 269 
Laps to complete, 165 
Latency, 184 
Launcher, 5, 277, 303 
License, 263 
Limbo, 158, 162 
List Server, 181, 303 
Look At, 118, 233 
Look From, 119 

M 
Manage User Files, 73 
Manual View, 236 
Map To, 139 
Max Players, 181 
Maximum Bar Height, 160 
Message Boards, 288, 290 
Metric Units, 51, 101, 117 
Microphone, 196 
Minimum Bar Height, 160 
Mode 1, 141 
Mode 2, 141 
Mode 3, 141 
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Mode 4, 141 
Movement Modes, 40 
MRU, 304 
MultiMode, 99, 187, 304 
Multiplayer, 99, 147, 177, 304 
Multiplayer Menu, 177 
Multiplayer Session, 179 
Mute Audio, 59 

N 
NaturalPoint, 239 
NavGuides, 5, 244, 251, 298, 304 
Night Flying, 3, 94 
Normal Camera, 47 
Notifications, 84 

O 
Object Palette Window, 52, 55 
Options, 173 
Orientation, 213, 219 

P 
Pan Camera, 46 
Parent, 45, 120, 304 
Particles, 93, 95 
Pass Through Interface, 142, 144 
Performance, 291 
PhotoField, 3, 304 
Physics, 100, 101 
Physics Frame Rate, 253 
Pilot Name, 99, 150, 155, 164 
Pilot Preview, 52, 56 
Pivot Camera, 46 
Play Engine Sounds, 116 
Playback Gadget, 194 
Player Kills Engine, 151 
Players, 184 
Port Number, 181, 184 
Preview Screen, 39 
Private, 305 
Probability, 90 
Properties, 52 
Properties Window, 54 
Public, 305 
Publish Hosting Information, 186 
Pylon Racing, 163, 166, 305 

Q 
Quick Look, 234 
QuickSelect, 3, 23, 24, 34, 35, 40, 109, 235, 

244, 246, 247, 248, 249, 305 

R 
Radio Gadget, 226, 245 
Radio Mode, 254 
Raw Panoramic Image, 69 
ReadySelect, 306 
RealFlight Archive, 70 
RealPhysics, 2, 306 
Recordings, 191 
Recordings Menu, 191 
Recordings MRU, 197 
Refresh Rate, 98 
Registration, 279 
Reload Color Scheme, 117 
Remember Aircraft Position, 127 
Reset, 129 
Resolution, 98 
Restore Defaults, 279 
Reverse Channel, 139 
RFX. See RealFlight Archive 
RotoSonics, 4 
RPM, 245, 252, 253 
Rudder, 272 

S 
Save Color Scheme, 124 
Scenery, 93 
Select Color Scheme, 123 
Select Controller, 134 
Select Level, 224 
Session Name, 181, 184 
Settings, 75 
Shadow, 93, 94, 95 
Show Title Bar, 242 
Simulation Menu, 37 
Software Radio, 307 
Sound Card, 8 
Specific Version, 281 
Speed, 252 
Split Screen. See MultiMode 
Spot Landing, 168, 171, 307 
Stick Mapping, 141 
Streamers, 5, 95 
Sun, 61 

Sun Azimuth, 62 
Sun Inclination, 62 

System Information, 283 
System Requirements, 7 

T 
Takeoff Trainer, 3, 200 
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Takeoffs, 268 
Targa (.tga) File Format, 125 
Target Scale, 151, 170 
Technical Support, 281, 283, 284, 288, 290 
Terrain Detail, 93 
Texture, 95 
Three Pylons on Course, 166 
Threshold Rules, 166 
Throttle cut altitude, 151 
Throttle Hold, 275 
Time to Complete Turn, 151, 156, 161, 170 
TrackIR, 239 
Training Aids, 28, 199, 308 
Training Menu, 199 
Transmitter, 15, 141 
Transmitter Mode, 140, 141, 143, 144 
Trees, 93 
TruFlo Wind Dynamics, 3, 308 
Turbulence, 104 

Layer Height, 104 
Micro-Turbulence Strength Proportion, 
105 
Strength Proportion, 104 

Turns Per Event, 150, 156, 161, 171 

U 
U.S. Patent, 33 
Uninstalling, 282 
Unlimited Fuel, 101 
Updates, 279, 289 
USB, 2, 308 

V 
Variable Pitch Prop, 3 

Variometer, 249, 309 
Vertical Sync, 98 
VFI. See Virtual Flight Instruction 
Video Card, 8 
View Menu, 229 
Viewport, 5, 25, 248, 309 
Viewport List, 256 
Virtual Flight Instruction, 4, 26, 224, 309 
VirtualRevolution, 4, 309 
Voltage, 252 

W 
Warnings, 85 
Water, 94 
Weather, 102 
Websites, 264 
Wind, 63, 102, 204, 208, 245, 253 

Global Wind, 102 
Wind Direction, 102 
Wind Gust, 103 
Wind Variation, 103 
Wind Velocity, 103 

Wind Direction, 64 
Wind Field Indicators, 94 
Wind Speed, 64 
Window Menu, 241 

Z 
Zone Point Values, 150, 170 
Zoom, 253 
Zoom In, 48, 237 
Zoom Out, 48, 237 
Zoom Reset, 48, 238 
Zoom Type, 235 
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License 
REGISTERED VERSION: RealFlight(r) R/C Simulator 

LIMITED USE SOFTWARE LICENSE AGREEMENT 

        This Limited Use Software License Agreement (the "Agreement") is a legal agreement 
between you, the end-user, and Knife  Edge Software ("KES").  By continuing the installation of 
this game program, by loading or running the game, or by placing or copying the game program 
onto your computer hard drive, you are agreeing to be bound by the terms of this Agreement.  If 
you do not agree to the terms of this Agreement, promptly return the game program and the 
accompanying items (including all written materials), along with your receipt to the place from 
where you obtained them for a full refund.  

KES SOFTWARE LICENSE 

        1.      Grant of License.  KES grants to you the limited right to use one (1) copy of the 
enclosed or foregoing game program (the "Software") on a single computer.  You have no 
ownership or proprietary rights in or to the Software or the written materials accompanying the 
Software.  For purposes of this section, "use" means loading the Software into RAM, as well as 
installation on a hard disk or other storage device.  The Software shall be either returned to KES 
or destroyed when no longer used in accordance with this Agreement, or when the right to use 
the Software is terminated.  You agree that the Software will not be shipped, transferred or 
exported into any country in violation of the U.S. Export Administration Act (or any other law 
governing such matters) and that you will not utilize, in any other manner, the Software in 
violation of any applicable law.  

        2.      Commercial Use is Prohibited.  Except as provided in paragraph 5. Herein below in 
regard to the Software, under no circumstances shall you, the end-user, be permitted, allowed or 
authorized to commercially exploit the Software, any data comprising the Software.  Neither you 
nor anyone at your direction shall do any of the following acts (any such acts shall be deemed void 
and a breach of this Agreement) with regard to the Software, or any portion thereof, such as a 
screen display or a screenshot:  

a. Rent the Software; 

b. Sell the Software; 

c. Lease or lend the Software; 

d. Offer the Software on a pay-per-play basis; 

e. Distribute, by electronic means or otherwise, the Software for money or any other 
consideration; or 

f. In any other manner and through any medium whatsoever commercially exploit the Software or 
use the Software for any commercial purpose.  
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        3.      Additional Prohibited Uses.  Neither you nor anyone at your direction shall take the 
following action in regard to the Software, or any portion thereof, such as a screen display or a 
screenshot:  

a. Modify, disassemble, reverse engineer or decompile Software;  

b. Translate the Software; 

c. Reproduce the Software; 

d. Publicly display the Software;  

e. Prepare derivative works based upon the Software except Permitted Derivative Works); or 

f. Distribute, by electronic means or otherwise, the Software.  

        4.     Use of Other Material is Prohibited.  Use, in any manner, of the trademarks, such as 
RealFlight R/C Simulator (tm) logo, or symbols, art work, images, screen displays or screenshots, 
sound effects, music, and other such material contained within, generated by or relating to the 
Software is prohibited. 

        5.      To Receive Permission to Commercially Exploit.  If you desire to commercially exploit 
the Software, you may request a copy of and execute the Commercial Exploitation License 
Agreement for RealFlight R/C  Simulator (the "License") and forward the original License to 
KES Software at the address noted therein.  Please note that KES may refuse your request and 
not sign the License in KES's sole discretion.  

        6.      Restrictions Apply to Third Parties.  The prohibitions and restrictions described herein 
apply to anyone in possession of the Software and/or Permitted Derivative Works.  

        7.      Copyright.  The Software and all copyrights related thereto (including all characters and 
other images generated by the Software or depicted in the Software) is owned by KES and is 
protected by United States copyright laws and international treaty provisions. You must treat the 
Software like any other copyrighted material. You may not otherwise reproduce, copy or disclose 
to others, in whole or in any part, the Software.  You may not copy the written materials 
accompanying the Software.  The same restrictions and prohibitions regarding your use of the 
Software as provided in this Agreement apply to your use of the written materials accompanying 
the Software.  The written materials are owned by KES and are protected by United States 
copyright laws and international treaties.  You agree to use your best efforts to see that any user of 
the Software licensed hereunder complies with this Agreement. 

 

        8.      Limited Warranty.  KES warrants that if properly installed and operated on a computer 
for which it is designed, the Software will perform substantially in accordance with the 
accompanying written materials for a period of ninety (90) days from the date of purchase of the 
Software.  KES's entire liability and your exclusive remedy shall be, at KES's option, either (a) 
return of the price paid or (b) repair or replacement of the Software that does not meet KES's 
Limited Warranty.  To make a warranty claim, return the Software to Hobby Services at 3002 
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North Apollo Drive, Suite #1, Champaign, IL 61822 accompanied by proof of  purchase, your 
name, your address, and a statement of defect, or return the Software with the above information 
to KES.  This Limited Warranty is void if failure of the Software has resulted in whole or in part 
from accident, abuse, misapplication or violation of this Agreement.  Any replacement Software 
will be warranted for the remainder of the original warranty period or thirty (30) days from your 
receipt of the replacement software, whichever is longer.  This warranty allocates risks of product 
failure between Licensee and KES.  KES's product pricing reflects this allocation of risk and the 
limitations of liability contained in this warranty.  

        9.      NO OTHER WARRANTIES.  KES DISCLAIMS ALL OTHER WARRANTIES, 
BOTH EXPRESS IMPLIED, INCLUDING BUT NOT LIMITED TO, IMPLIED 
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE WITH RESPECT TO THE SOFTWARE AND THE ACCOMPANYING 
WRITTEN MATERIALS.  THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL 
RIGHTS.  YOU MAY HAVE OTHER RIGHTS WHICH VARY FROM JURISDICTION 
TO JURISDICTION.  KES DOES NOT WARRANT THAT THE OPERATION OF THE 
SOFTWARE WILL BE UNINTERRUPTED, ERROR FREE OR MEET LICENSEE'S 
SPECIFIC REQUIREMENTS.  THE WARRANTY SET FORTH ABOVE IS IN LIEU OF 
ALL OTHER EXPRESS WARRANTIES WHETHER ORAL OR WRITTEN.  THE 
AGENTS, EMPLOYEES, DISTRIBUTORS, AND DEALERS OF KES ARE NOT 
AUTHORIZED TO MAKE MODIFICATIONS TO THIS WARRANTY, OR 
ADDITIONAL WARRANTIES ON BEHALF OF KES.  ADDITIONAL STATEMENTS 
SUCH AS DEALER ADVERTISING OR PRESENTATIONS, WHETHER ORAL OR 
WRITTEN, DO NOT CONSTITUTE WARRANTIES BY KES AND SHOULD NOT BE 
RELIED UPON. 

        10.     Exclusive Remedies.  You agree that your exclusive remedy against KES, its affiliates, 
contractors, suppliers, and agents for loss or damage caused by any defect or failure in the 
Software regardless of the form of action, whether in contract, tort, including negligence, strict 
liability or otherwise, shall be the return of the purchase price paid or replacement of the Software.  
This Agreement shall be construed in accordance with and governed by the laws of the State of 
Oregon. Copyright and other proprietary matters will be governed by United States laws and 
international treaties.  IN ANY CASE, KES SHALL NOT BE LIABLE FOR LOSS OF DATA, 
LOSS OF PROFITS, LOST SAVINGS, SPECIAL, INCIDENTAL, CONSEQUENTIAL, 
INDIRECT OR OTHER SIMILAR DAMAGES ARISING FROM BREACH OF 
WARRANTY, BREACH OF CONTRACT, NEGLIGENCE, OR OTHER LEGAL 
THEORY EVEN IF KES OR ITS AGENT HAS BEEN ADVISED OF THE POSSIBILITY 
OF SUCH DAMAGES, OR FOR ANY CLAIM BY ANY OTHER PARTY. Some 
jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so 
the above limitation or exclusion may not apply to you.  

        11.     General Provisions.  Neither this Agreement nor any part or portion hereof shall be 
assigned, sublicensed or otherwise transferred by you.  Should any provision of this Agreement be 
held to be void, invalid, unenforceable or illegal by a court, the validity and enforceability of the 
other provisions shall not be affected thereby.  If any provision is determined to be unenforceable, 
you agree to a modification of such provision to provide for enforcement of the provision's intent, 
to the extent permitted by applicable law.  Failure of a party to enforce any provision of this 
Agreement shall not constitute or be construed as a waiver of such provision or of the right to 
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enforce such provision.  If you fail to comply with any terms of this Agreement, YOUR 
LICENSE IS AUTOMATICALLY TERMINATED.  

        YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, THAT 
YOU UNDERSTAND THIS AGREEMENT, AND UNDERSTAND THAT BY 
CONTINUING THE INSTALLATION OF THE SOFTWARE, BY LOADING OR 
RUNNING THE SOFTWARE, OR BY PLACING OR COPYING THE SOFTWARE 
ONTO YOUR COMPUTER HARD DRIVE, YOU AGREE TO BE BOUND BY THIS 
AGREEMENT'S TERMS AND CONDITIONS.  YOU FURTHER AGREE THAT, 
EXCEPT FOR WRITTEN SEPARATE AGREEMENTS BETWEEN KES AND YOU, 
THIS AGREEMENT IS A COMPLETE AND EXCLUSIVE STATEMENT OF THE 
RIGHTS AND LIABILITIES OF THE PARTIES. THIS AGREEMENT SUPERSEDES 
ALL PRIOR ORAL AGREEMENTS, PROPOSALS OR UNDERSTANDINGS, AND ANY 
OTHER COMMUNICATIONS BETWEEN KES AND YOU RELATING TO THE 
SUBJECT MATTER OF THIS AGREEMENT. 
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